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1 System description
This manual describes how to install and operate the control software for the
CulinaFlex feeding system for suckling pigs. The CulinaFlex system automatically and
continuously supplies milk replacers, prestarters or starter feed to piglets in the
farrowing pen. The feed is supplied by a feed valve (time-controlled). When feeding is
completed, air under pressure can squeeze the flexible hose inside the feed drop pipe,
which thus functions as a pinch valve, to push all remaining feed out of the hose. The
hose remains pressed together until the next feeding. This creates an anaerobic
environment in which bacteria cannot multiply. The compressed air escapes from the
pipe when the next feeding starts. The feed can now drop from the hose inside the feed
pipe into the trough. This requires that the feed drop pipe is designed as a pinch valve.    

CulinaFlex is controlled by the CulinaMixpro application with the BigFarmNet Manager
software. One application can control up to 3 tanks, which run separately. This means
that if one tank goes into error mode (no system alarm!) or is in idle mode, the other
tanks continue to provide feed.

1.1 Licenses

The CulinaMixpro application uses the 510pro control computer to control the
CulinaFlex feeding system for suckling pigs. The CulinaFlex feeding system can be
controlled independently of BigFarmNet Manager by the 510pro control computer. This
means that only the following software license is required:

If no BigFarmNet Manager software is installed but the operator wants to monitor the
system with BigFarmNet Manager, the optional basic installation software license is
required.

Code no. BigFarmNet Manager license Use
91-02-6602 License 510 – BigFarmNet CulinaMix 1 per control computer
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The following software licenses are optional:

1.2 System limits

Code no. BigFarmNet Manager license Use
91-02-6500 BigFarmNet Manager – Basic installation 

software
1 per BigFarmNet network

91-02-6551 BigFarmNet Manager per additional PC/
MC700

In case animal and system 
data in the BigFarmNet 
Manager is to be available 
on additional computers

1 to 3 Mixing tanks
600 Feed valves 
32 Feed components
10 Feeding times per mixing tank
10 Silos per mixing tank
4 Mineral dosing units per mixing tank
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2 Setting up the BFN Manager PC and 510pro control 
computer

To set up the Control computer 501pro and the BFN Manager PC,

1. connect the Control computer 501pro to the network,

2. check the communication between the Control computer 501pro and the BFN
Manager PC,

3. register the Control computer 501pro in BFN Manager,

4. install the BFN software on the Control computer 501pro,

5. assign the CulinaFlex application to the Control computer 501pro and the farm
structure in BFN Manager,

6. assign the electrical parts of the CulinaFlex system to the IO cards in the IO
Manager.

NOTICE!

Only service technicians may install and configure the control computer. 

Figure 2-1: Control computer 510pro

NOTICE!

The operator's IT administrator is responsible for defining the static IP addresses.
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NOTICE!

Please contact the customer's IT administrator to determine the IP addresses in the
network.

2.1 Connecting the 510pro control computer to the network 
(assigning a static IP address)

1. On the start screen, tap on Settings.

2. Tap on Service and then on Network.

3. Tap on IP configuration mode.
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4. Under "Selected network scheme", make sure that Static is selected.

5. Tap on IP address.

6. Enter the IP address defined for this control computer. Complete your input by
tapping on Confirm.

7. Continue in this manner to enter the values for Net mask and Gateway IP
address.

2.2 Manager PC: assigning a static IP address

NOTICE!

A static IP address must be assigned to the BFN Manager PC.

If necessary, assign this address via the network settings in the Windows control panel
before setting up the Control computer 501pro.

Assign a static IP address to the PC on which BigFarmNet Manager is installed or will
be installed. The following steps correspond to the Windows 10 operating system.
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Windows 10 operating system

1. Open the Control Panel using the search field in the task bar. 

2. Click on View network status and tasks under Network and Internet.
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3. Click on Change adapter settings.

4. Double-click on Wi-Fi.

5. Click on Properties.
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6. Select Internet Protocol Version 4 (TCP/IPv4) and click on Properties.

7. Enter a static IP address.

8. Confirm these inputs by clicking on OK.
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Windows 11 operating system

1. Open the Control Panel using the search field in the task bar. 

2. Click on Network and Sharing Center.
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3. Click on Change adapter settings.

4. Select the correct adapter.

5. Click on Properties.
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6. Select Internet Protocol Version 4 (TCP/IPv4) and click on Properties.

7. Enter the values for IP address and Subnet mask.

8. Confirm these inputs by clicking on OK.
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2.3 Assigning a network card

The network card is read during the first start of BigFarmNet Manager. Its assignment
can be changed later on as follows:

1. Click on the network icon.

2. Click on "Communication".

3. Click on "Communication settings".

4. Select the correct network interface. The first three octets of the IP address must
match those you have entered for the Manager PC beforehand.

5. Click on "OK" to accept these settings.
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2.4 Testing the communication between control computer and BFN 
Manager PC

Use the "ping" command to check whether the control computer is available in the
network. 

Enter the command into the console as follows: ping <IP address> 

Example in the screenshot: ping 192.168.128.236

If the control computer replies, four lines with the following information will appear:

• IP address;

• packet size;

• required time;

• TTL (time to live).
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2.5 Installing the BFN software on the 510pro control computer

Upon delivery, the control computer has an operating system pre-installed. The
corresponding BigFarmNet software must be installed additionally. 

1. Click on "Software installer" in the "Setup" menu.

2. Enter the IP address of the control computer on which you want to install the
software.

3. If necessary, add the desired number of control computers by clicking on "Add". 

This feature allows you to install the software simultaneously on multiple control
computers. Each click on "Add" adds another control computer and the IP address
increases by 1. However, you may change the IP address according to your
wishes.

4. Click on a control computer to select it.
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5. Click into the respective input field under "Action type" and select "New
Installation".

6. Click on "Settings" in the lower command bar of the dialog window.

7. Under "Software package", check whether the setup for the 510pro control
computer is stored under the indicated path. 

NOTICE!

When updating, check whether the update's version number in the software package
corresponds to the version you want to install.
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8. Confirm the dialog by clicking on "OK".

9. Click on "Start".

10. Confirm the prompt for confirmation.
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The installation process may take a few minutes. Click on  to receive more
information on the progress.

Successful installation is indicated by a checkmark  in the "Status" column.

2.6 Assigning the control computer and application to the farm 
structure

1. Click on "Configurator" in the "Setup" menu.

This opens the "Configurator" window.

2. Click on the "Control computer and applications" tab. 

3. Select the correct control computer in the upper part of the window under "Control
computer" and click on the plus button.

The control computer is now added on the left under "Control computer overview". 
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4. Enter a name for the control computer.

5. From the lower part of the window, select the location where the system is to be
operated.

The applications available for selection depend on the selected location.

The HydroMixPro and CulinaMixPro applications can only be added to the "House"
level.
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6. Select the correct application in the table on the right and click on the plus button
to the left. 

The selected application is assigned to the control computer on the left under
"Control computer overview". In the structure, the control computer is displayed on
the upper level and the respective application on the lower level.

7. Enter a name for the application.
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8. Click on the level of the control computer in the left-hand part of the window under
"Control computer overview".

9. Assign the corresponding IP address to the control computer, if known.

If the IP address has not been set up yet, you will need to add it later on. 

10. Save your settings by clicking on "Save" and confirm the next dialogs with "OK".
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3 Configuration of the system
The configuration of the CulinaMixpro system with all system components and
functionalities is mapped in BigFarmNet Manager using the Composer and the
FeedMove Editor.

Composer

All possible system components of a CulinaMixpro system are listed in the Composer. 

Select the correct component quantities of the system to be controlled.

FeedMove Editor

The system components selected in the Composer are displayed graphically in the
FeedMove Editor. The feed move connections between the system components are
also mapped.

3.1 Configuring settings in the Composer 

Define the functional range and configure settings according to the system's structure
in the Composer. These settings are usually configured once.

3.1.1 Defining components of the CulinaFlex system

1. Click on the controller icon  of the respective system application in the farm
structure.
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NOTICE!

Check whether the system is running. Stop the system by clicking on  in the
upper bar. 

2. Under "Setup", click on "Start Composer...".

3. Click on the plus icon to show hidden parameters. 

Also open subordinate parameters by clicking on the respective plus icon.

4. Configure the settings in accordance with the structure of the CulinaFlex system.
Change pre-set values, if necessary. 

The column "Comment" contains information for setting of the values.
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5. Proceed as follows to delete system components:

a) Enter the new quantity (a lower number or 0) and press Enter. 

This opens a new dialog window that shows the system components with their
assigned locations. 

b) Select the object(s) you wish to delete and click on "Next". 

c) In the next window, confirm that you want to delete the object(s) shown by
clicking on "Delete".
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6. Click on "Save" to accept all settings for the Composer.

The following section explains the parameters:

Mixing tanks: Number of existing mixing tanks.

Connection type:

• "Shared" = One subcircuit takes feed from all mixing tanks.

• "Separated" = One subcircuit takes feed from one mixing tank.
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Subcircuit groups: Number of subcircuit groups. Divide the number of main circuits
by the number of mixing tanks to calculate the number of subcircuit groups.

Remaining feed tanks: Number of remaining feed tanks. A remaining feed tank is a
container into which feed can be pumped, e.g. before cleaning. Feed from the
remaining feed tank can still be provided to the animals.

Slurry tank: The system contains a slurry tank.

Security lock: This information depends on how the security relay(s) is/are connected
in the control box, i.e. whether there is one relay for the entire system (= for the entire
application) or one relay per tank.

With protective grid: All mixing tanks are equipped with a protective grid. The agitator
then continues running even when the tank lid is open. Deactivate this parameter box
if you want to remove protective grids.

Common water supply: All mixing tanks share the same cold water and warm water
tank.

Accessories: Add additional system components such as valves, pumps and augers
subsequently below "Accessories".

Manual switches: Number of manual switches.

Control: Define, for example, the number of junction boxes 16 outputs 18 inputs as a
function of the number of feed valves as well as the start and end valves under
"Control" > "Control box". These junction boxes are not installed in the control box,
however, but in the central aisle.

3.1.1.1 Mixing tanks
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Feed pumps: Number of existing feed pumps.

• Pump control: Type of control of the feed pump ("Frequency inverter", "Direct
switch-on", "Shared frequency inverter").

• Bypass valve: A bypass valve is installed parallel to the feed pump.

• Pump dry-run protection sensor: The feed pump is protected against running
dry.

• Pump water impulse valve: A water impulse valve is installed. Water is injected
into the feed pump through this valve at the beginning of or during the pumping
process, which makes the pump start up more easily.

Each mixing tank has its own component supply it does not share with any other tank.
This means that the silo only supplies the mixing tank it was assigned to, and no other
tank.

Silos: Number of existing silos.

• Agitator: Type of agitator of the silo ("None", "Direct switch-on", "Tapped winding",
"Frequency inverter").
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• Vibrator: The silo has a vibrator. The vibrator is activated if no components are
removed within the set dosing time. The goal is to dispense components from the
silo. As soon as a minimum dosing speed has been reached, the vibrator switches
off again while dosing continues.
If no components are removed from the silo within the dosing time despite a
running vibrator, the system either switches to a replacement silo or generates an
alarm.

• Scale: The silo has a scale. The scale monitors the weight of the silo and
generates an alarm in the event of unexpected weight loss.

• Sensors: Sensor type for the fill level monitoring of the silo.

• "None" = no sensors for fill level monitoring of the silo.

• "Min sensor" monitors the minimum fill level in the silo.

• "Max sensor" prevents overfilling of the silo.

• "Min and max sensors" = "Min sensor" + "Max sensor".

• Dosing screw control: Type of control of the discharging auger in the silo
("Frequency inverter", "Direct switch-on", "Shared frequency inverter").

• Shared access: Type of parallel removal from e.g. two different tanks or
applications at the same time.

• "None" = no parallel removal possible.

• "Without shared devices" = parallel removal only possible by processes that do
not share devices.

• "With shared devices" = parallel removal also possible by processes that share
devices.

Liquid silos: Number of existing liquid silos.

• Agitator: Type of agitator of the liquid silo ("None", "Direct switch-on", "Tapped
winding", "Frequency inverter").

• Scale: The liquid silo is weighed.

• Sensors: Sensor type for the fill level monitoring of the liquid silo.

• "None" = no sensors for fill level monitoring of the liquid silo.

• "Min sensor" monitors the minimum fill level in the liquid silo.

• "Max sensor" prevents overfilling of the liquid silo.

• "Min and max sensors" = "Min sensor" + "Max sensor".

• Recirculation: Component recirculation is possible.
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• Pump control: Type of control of the component pump ("Frequency inverter",
"Direct switch-on", "Shared frequency inverter").

• Pump dry-run protection sensor: The component pump is protected against
running dry.

• Pump water impulse valve: A water impulse valve is installed. Water is injected
into the component pump through this valve at the beginning of or during the
pumping process, which makes the pump start up more easily.

• Shared access: Type of parallel removal from the liquid silo.

• "None" = no parallel removal possible.

• "Without shared devices" = parallel removal only possible by processes that do
not share devices.

• "With shared devices" = parallel removal also possible by processes that share
devices.

Dry mineral dosing units: Number of small quantity dosing units available for dry
components or additives.

• Agitator: Type of agitator of the small quantity dosing unit ("None", "Direct switch-
on", "Tapped winding", "Frequency inverter").

• Vibrator: The small quantity dosing unit has a vibrator. The vibrator is activated if
no components are removed within the set dosing time. The goal is to dispense
components from the small quantity dosing unit. As soon as a minimum dosing
speed has been reached, the vibrator switches off again while dosing continues.

• Min sensor: A minimum sensor for fill level monitoring is installed.

Liquid mineral dosing units: Number of small quantity dosing units available for liquid
components or additives.

• Valve to tank: A valve to the mixing tank is installed.

• Agitator: Type of agitator of the small quantity dosing unit ("None", "Direct switch-
on", "Tapped winding", "Frequency inverter").

• Pump control: Type of control of the component pump ("Frequency inverter",
"Direct switch-on", "Shared frequency inverter").

• Pump dry-run protection sensor: The component pump is protected against
running dry.

• Pump water impulse valve: A water impulse valve is installed. Water is injected
into the component pump through this valve at the beginning of or during the
pumping process, which makes the pump start up more easily.

• Min sensor: A minimum sensor for fill level monitoring is installed.
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Bunker silos: Number of components that are dispensed manually.

Fresh water supply:

• Shared access: Type of parallel removal from the cold water tank/warm water
tank.

• "None" = no parallel removal possible.

• "Without shared devices" = parallel removal only possible by processes that do
not share devices.

• "With shared devices" = parallel removal also possible by processes that share
devices.

Mixing tank:

• Agitator: Type of agitator of the mixing tank ("Direct switch-on", "Tapped winding",
"Frequency inverter").

• Agitator feedback signal: If there is no feedback signal from the agitator after
switching on the agitator, an alarm is generated.

• Foggers: Number of foggers for acids or lyes that are installed in the mixing tank.

• Input flaps: Number of meal inlet flaps that are installed.

• pH sensor: A pH sensor is installed.

Monitoring:

• Alarm inputs sub-application: Number of alarm sensors that do not stop the
entire application, but only the corresponding sub-application.

• Manual switch count: Number of manual switches for monitoring.
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• Type: Type of the manual switch ("TASKSTARTSTOP",
"APPSTARTSTOPBUTTON", "APPPAUSESWITCH").

3.1.1.2 Subcircuit groups:

Subcircuits: Number of subcircuits that are installed in the subcircuit group.

• Troughs: Number of troughs in the subcircuit.

Common main circuit valve subcircuit groups: Number of subcircuit groups that
share the same main circuit valve.

• Subcircuits: Number of subcircuits that are installed in the subcircuit group.

• Troughs: Number of troughs in the subcircuit.

3.1.1.3 Accessories

You may add additional system components such as valves, pumps and augers for the
feed move route later on below this parameter.

Valves: Number of additional valves.

Pumps: Number of additional pumps.

• Pump control: Type of control of the pump ("Frequency inverter", "Direct switch-
on", "Shared frequency inverter").

• Pump dry-run protection sensor: The pump has a dry-run protection sensor.

• Pump water impulse valve: A water impulse valve is installed. Water is injected
into the pump through this valve at the beginning of or during the pumping process,
which makes the pump start up more easily.
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Pipe connectors: Number of additional pipe connectors.

Connecting augers: Number of connecting augers.

Cross conveyors: Number of cross conveyors.

Collecting augers: Number of collecting augers.

Temperature sensors: Number of temperature sensors.

Alarm inputs: Number of additional alarm inputs.

External synchronisations: Number of external synchronizations.

App connector ins: Number of app input connections.

App connector outs: Number of app output connections.

Dosing screws: Number of dosing augers.

• Dosing screw control: Type of control of the dosing auger ("Frequency inverter",
"Direct switch-on", "Shared frequency inverter").

Label for user-defined text: Number of user-defined labels, see chapter 3.6 ”Editing
a user-defined label”, page 84.

Additional outputs: Number of additional outputs.

3.1.1.4 Manual switches

Manual switch count: Number of manual switches.

Type: Type of manual switch ("TASKSTARTSTOP", "APPSTARTSTOPBUTTON",
"APPPAUSESWITCH").
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3.1.1.5 Control unit

Water meters: Number of water meters.

Shared frequency inverters: Number of shared frequency inverters.

Timed relay: Number of time relays.

Output devices PLC: Number of output devices for PLC.

Input devices PLC: Number of input devices for PLC.

Display PLC: Number of displays for PLC.
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Control box

• Weighing box CAN bus: Number of weighing boxes (CAN).

• Weighing box V3: Number of weighing boxes V3.0 (CAN).

• Junction box 16 out 18 in: Number of junction boxes with 16 outputs and 18
inputs.

• Junction box 16 out 2 in: Number of junction boxes with 16 outputs and 2 inputs.

• Junction box 32 out 4 in: Number of junction boxes with 32 outputs and 4 inputs.

• Junction box 16 out 2 in 16 analog sensors: Number of junction boxes with 16
outputs, 2 inputs and 16 analog sensors.

• Frequency inverter Frenic Multi: Number of Frenic Multi frequency inverters.

• Frequency inverter Frenic ACE: Number of Frenic ACE frequency inverters.

• Frequency inverter Altivar312: Number of Altivar312 frequency inverters.

• Frequency inverter Altivar320: Number of Altivar320 frequency inverters.

• Motor controller 24 V: Number of 24 V motor controllers.

• Digital module BDDIO32: Number of digital modules BDDIO32.

• Digital module BDDIO32LC: Number of digital modules BDDIO32LC.

• Analog module BDAM48: Number of analog modules BDAM48.

• Jumo pressure transmitter 402056: Number of Jumo pressure transmitters
402056.

• Intelligent valve module V4: Number of V4 intelligent valve modules.

• Gateway CAN Izumi Lohbus: Number of Izumi/Lohbus CAN gateways.

• Bus: Bus ("Lohbus", "Izumi").

• BDM Adapter V25: Number of V25 BDM adapters.

• Input card HLI 16 in: Number of HLI input cards with 16 inputs.

• Output card HLO 32 out: Number of HLO output cards with 32 outputs.

• BDP Digital 16/16 card: Number of BDP Digital 16/16 cards.

• Valve module intelligent valves vers. 2: Number of intelligent valve modules
version 2.

• Relay module MC99 24 relays: Number of MC99 relay modules with 24
relays.

• Valve module MC99 200 valves: Number of MC99 valve modules with 200
valves.

• Nano Intelligent CAN coupler: Number of Nano Intelligent CAN bus couplers.
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• Nano_analog_in_8: Number of Nano I/O module boards, analog in (8 inputs).

• Nano_analog_in_8_Temperature: Number of Nano I/O module boards,
analog in (8 inputs) – temperature.

• Nano_analog_out_8: Number of Nano I/O module boards, analog out (8
outputs).

• Nano_digital_in_8: Number of Nano I/O module boards, digital in (8 inputs).

• Nano_digital_out_8: Number of Nano I/O module boards, digital out (8
outputs).

• Nano_relay_8_NO: Number of Nano I/O relay cards (8 relay outputs).

• Nano_analog_in_2_Ph: Number of Nano I/O analog in 2 Ph cards.

• Display AMZ1: Number of displays type AMZ1 (UniScale).

• Tag reader: Number of transponder readers.

• Tag reader type: Transponder reader type ("BDP antenna", "BDP antenna
V2", "RFID box").

• QuadScale_HouseLink_HL10C: Number of QuadScale houselink cards.

• Valve Sensor Plus cards: Number of valve sensor cards with additional outputs
for status lamps.

3.1.2 Allocation to the farm structure

If the system is integrated into an existing BigFarmNet network, the corresponding
location must be assigned to the system and/or the individual system components. If
the BigFarmNet network is installed at the same time as the system (application), the
location does not need to be adjusted.

1. Click on the "Details" tab. Expand the structure by clicking on the plus icon. 

The structure shows all location-related components of the system.
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2. Click on the house icon next to the correct system component. 

3. In the next window, enter the number of the correct location.

The selected location is displayed in its entirety below the input field. 
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4. If necessary, check the box "Recalculate below". 

All below (subordinate) system components are then automatically assigned to the
new location. 

5. Click on "Next" to continue assigning locations to the system components on the
same level. 

6. Click on "OK" after you have finished to accept the input. 

Click on "Save" to accept all settings for the Composer.

Confirm the dialog by clicking on "OK".

The FeedMove Editor opens.
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3.2 Depicting the system in the FeedMove Editor 

The Feedmove Editor is a program used to edit the graphical depiction of the installed
system. All system components you have created in the Composer are displayed as
icons in the FeedMove Editor. In the FeedMove Editor, you can connect the individual
system components according to the installed system. You thus define the route of the
feed move. 

NOTICE!

Automatically generated feed moves must be edited!

The completed depiction is displayed in the "View" application window. The image
shows the system's activity during operation.

1. Click on the controller icon  of the respective system application in the farm
structure.

2. Under "Setup", click on "Start FeedMove Editor".

The FeedMove Editor opens in a new window. 
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3.2.1 Icons of the system components

Dry silo

Liquid add-on unit, agitator and minimum sensor

Dry mineral dosing unit

Liquid mineral dosing unit

MediINJECT

CCM

Bunker silo

Fresh water tank

Used water tank

Pre-mixer

Mixing tank
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Cross conveyor

Collecting auger

Dosing auger / FlexVey 

Feed valve 

Heat exchanger 

Compressed air monitoring 

Reciprocating compressor 

Feed pump 

Pump general

Vibrator 

Agitator

Pressure sensor

Valve 

Pinch valve 

Cleaning valve 

Input flap 

Fogger 

Cleaner 

Security lock / tank blocking 
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3.2.2 Basic functions

3.2.3 Configuring the grid

If you want to align the system components based on a grid, click on . Adjust the
size of the grid as follows, if necessary:

1. Click on "Grid settings" in the "View" menu.

Blade CCM 

Slope auger CCM 

Drive

Pipe connector

View Complete view of the system 

Grid Hide / show grid lines

Zoom in / zoom out Zoom into / out of the view

Description boxes 
(labels)

Hide / show description boxes of specific 
system components

Undo / redo Undo / redo an action

Camera Save different views of the system
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2. Enter the correct values into the input fields or change them using the arrows
pointing upwards and downwards. 

3. Accept these inputs by clicking on "OK".

3.2.4 Adjusting and saving views

NOTICE!

The below mentioned functions of the mouse depend on how you have configured your
mouse in Windows.

Adjust the desired view of the window as follows in the drawing pane: 

• Zooming in and out: 

– Roll the scroll wheel of your mouse.

• Moving to the left and to the right:

– Hold down the scroll wheel and move the mouse to the right or to the left.

OR 

Hold down the Shift key while rolling the scroll wheel of your mouse.

• Moving up and down:

– Hold down the scroll wheel and move the mouse up or down.

OR

Hold down the Control (Ctrl) key while rolling the scroll wheel of your mouse.

You can save up to 5 different views: one view for each camera icon. Saved views can
be retrieved later on in the window "View".

1. Adjust the view as follows:

– Zooming in and out: Roll the scroll wheel of your mouse.

– Moving to the left and to the right: Hold down the Shift key while rolling the
scroll wheel of your mouse.
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– Moving up and down: Hold down the Control (Ctrl) key while rolling the scroll
wheel of your mouse.

OR

Press the scroll wheel of your mouse to move the image (two-dimensional) into
all directions.

2. Click on the arrow pointing downwards at one of the camera icons. 

3. Click on "Current view" in the context menu. The view is now saved.

4. If you would like to retrieve the saved view later on, click on the corresponding
camera icon. 

3.2.5 Selecting and moving system components

1. Move the mouse pointer over the respective system component.

The mouse pointer will change its shape . The name of the system component
is additionally displayed as tooltip for a moment. 

2. Click on the system component and hold the mouse button.

The colour of the system component changes to orange.

3. Move the system component to the required position and release the mouse
button. 

Or:

1. Select multiple system components
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a) by drawing a rectangle over the system components while holding the left
mouse button

Or:

by clicking on the different system components while holding the Ctrl key. 

The colour of the selected components changes to orange.

2. Click into the selected area and hold the mouse button.

3. Move the system component to the required position and release the mouse
button. 

NOTICE!

You can also move objects that are marked orange using the arrow keys on your
keyboard.

3.2.6 Linking system components

The links between system components, also called feed moves, are pre-defined by
default. 

NOTICE!

If you would like to use the default feed moves, make sure that they are possible with
the system you have installed. 

To link system components, you might have to delete existing links first.

• Deleting individual links:

a) Move the mouse pointer to the link you want to change. 

The mouse pointer will change its shape . 

b) Click on the link.

The colour of the link changes to orange.

c) Press the "Delete" key on your keyboard.

The link is deleted.
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• To delete all links, click on "Delete all feedmoves" in the menu "Edit".

• Resetting to default: For EcoMatic, the system components are connected
automatically by default links. If this configuration has been changed, you may
reset the default links and continue using this default. 

In the menu "Edit", click on "Reset connections to default layout 'Standard'".

1. Move your mouse pointer to the red dot of the specific system component.

The mouse pointer will change its shape . 

2. Click on the red dot and hold the mouse button.

3. Move the mouse pointer over the icon of the system component to which you want
to link the selected system component.

The mouse pointer will change its shape  and a line linking both components
appears. The flow direction is indicated by an arrow within the line.
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4. Release the mouse button.

The two system components are now linked.

Linked system components without green or red dot cannot be linked further.

5. Continue linking all system components so that all feed move routes are displayed
correctly.

3.2.7 Adding system components subsequently

If you need additional system components for a system you have already generated
with the FeedMove Editor, such as pipe connectors or valves, you must return to the
Composer. Select all additionally required system components in the Composer below
the parameter "Accessories", see chapter 3.1.1.3 ”Accessories”, page 31. 

3.2.8 Changing the flow direction 

You may define both flow directions for the feed in all pipes in the FeedMove Editor. An
arrow at the pipes shows the flow direction and is defined for one specific direction by
default. 

1. Click on the respective line to mark it.

2. Right-click on the selected line to open the context menu. 

3. Select "Connection bidirectional".

Two arrows appear at the line, indicating both flow directions. 
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3.2.9 Configuring feed moves

At first, feed moves include all possible feed routes between the different system
components, also called nodes. Use these nodes to define the feed moves so that the
system knows exactly which feed move is the correct one. This reduces the number of
possible feed moves to those that are absolutely mandatory.

NOTICE!

Only service technicians may configure the feed moves using the nodes. 

1. Click on the respective line to mark it.

2. Right-click on the selected line to open the context menu.
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3. Select "Mandatory nodes". 

This opens the dialog window "Mandatory nodes".

4. Click on "Add".
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5. Click on the correct node in the graphic (system component, example: used water
tank). 

6. Define the selected node as "Source", "Target" or "Both".

7. Add further nodes to the installed system as described above, depending on its
structure. 

8. Click on "OK" to accept these settings.

3.2.10 Closing the FeedMove Editor

To finish working in the FeedMove Editor, save and close the program: 
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1. Save your work by clicking on "File" > "Save" and close the program by clicking on
the X in the upper right corner. 

OR:

Close the program directly by clicking on the X in the upper right corner.

The software automatically recognizes unsaved changes and shows a warning.      

2. Click on "Yes" to save your changes.

After saving the changes in the FeedMove Editor, a new dialog appears, prompting
the restart of the Control computer 501pro.

3. Confirm the dialog by clicking on "OK".

4. Click on "Software installer" in the "Setup" menu.

5. Click on the control computer to select it.

6. Click into the corresponding input field under "Action Type" and select "Reboot
Controller".
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7. Click on "Start". 

NOTICE!

This process may take a few minutes!
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3.3 Configuring the IO Manager

The controller is configured in the IO Manager. Assign the system functions that you
defined in the Composer in the previous step to the IO cards.

1. Click on the controller icon  of the respective system application in the farm
structure.

2. Click on "IO Manager" in the "Setup" menu. 

The IO Manager opens in the application window. The left-hand part of the window
shows the individual devices of the system under "Device". The right-hand part of
the window displays the channels of the IO cards under "Channel".
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Adjust the view in the IO Manager as follows using the upper bar:

–  Expanding or collapsing the structure entirely

– Displaying the device and/or channel according to the link state

– Enabling or disabling the edit mode, in which you can edit device names and
create links between devices and IO cards manually with your keyboard

–  Displaying control box numbers and indexes; displaying feed valves
without location names

– Showing the channel according to the channel type

– Displaying all relevant cards to also display the IO cards of other applications
of the NetFEED group that are connected to devices of the own application

The interfaces of the devices and the IO cards are indicated by the following icons:

–  Digital output 

–  Digital input 
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–  Analog output 

–  Analog input 

–  Counter input 

–  Serial interface 

– Linked interfaces are colored: 

– Non-linked interfaces are grayed out: 

3.3.1 Order of the IO cards: Lohbus, Izumi

If you use Lohbus or Izumi IO cards, the order of the IO cards in the IO Manager must
match that in the control cabinet. Both Lohbus and Izumi are automatically added to the
IO Manager after you have selected them in the Composer. The order of the IO cards
is arbitrary in the IO Manager.   

NOTICE!

Sort the Lohbus and Izumi IO cards in the IO Manager before creating any links. 

The following instructions explain how the Lohbus IO cards are sorted. The Izumi IO
cards are sorted in the same way. 

1. Right-click on one of the Lohbus cards to open the context menu. 

2. Click on "Bus node settings" in the context menu. 

This opens a new dialog window with the settings.

3. Click on the tab "Connected I/O cards". 
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4. Sort the IO cards that appear in the small view window: 

a) Click on one IO card.

b) Change the position of the IO card using the arrows pointing upwards and
downwards. 

NOTICE!

Number the IO cards consecutively, starting with the first card behind the gateway
when sorting the IO cards. 

c) Save the defined order by clicking on "Save". 

5. Close the dialog window for settings by clicking on the button "Close". 
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3.3.2 Creating links

Link the different devices manually with the corresponding IO card. The system
currently does not support the "Default mapping" function (button). 

1. Change one or more inputs to outputs with the supply voltage +24 V in the
"Channel" area, where necessary. 

The default shows only inputs at first. 

This function is only possible for IO cards type BDDIO32 and BDDIO32LC. 

a) Select one input or select multiple inputs by holding the Ctrl key.

Multiple editing is only possible for channels of the same type.

b) Right-click into the marked area.

c) In the context menu, select "Switch to output" > "High side", if the new output
should switch to high side (24 V).

OR:

In the context menu, select "Switch to output" > "Low side", if the new output
should switch to low side (ground).

d) If necessary, you can invert the polarity of the signal by clicking on "Polarity" >
"Inverted" in the context menu. 

2. Select one of the following options to link the interfaces:

Option 1:
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a) Click on the interface of the respective system component and hold the mouse
button.

b) Hold the mouse button and move the mouse to the interface of the correct
channel, then release the button. 

The system component and the channel are now linked. The icons are colored
. 

Option 2:

a) Activate the edit mode in the upper bar.

b) The IO card interfaces have numbers. Enter the corresponding number for the
system component's interface. 

The system component and the channel are now linked. The icons are colored
. 

3. If you have created an incorrect link, right-click on the corresponding linking icon.
Click on "Delete connection" in the context menu.

NOTICE!

Checking links:

Double-click on the respective device to mark the linked channel.

4. Click on "Save" in the bottom command bar after having established all links.  
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5. Click on "Restart application" at the top of the window to start the control.

3.3.3 Calibrating the scale

You may calibrate the scale as soon as you have created a link between the scale or
its weighing bars and the respective weighing box.

1. Right-click on the connected scale or its subordinate weighing bars in the "Device"
area.

2. In the context menu, click on "Calibrate".

This opens a new dialog window.

3. To calibrate, click on the "Calibration" tab. 
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4. Enter the weight (usually the value 0) for calibration point 1 and click on "Set" in the
"Set raw value" column.

5. Enter the weight used for calibration for calibration point 2.

6. Load CulinaFlex with the calibration weight.

7. Click on "Set" in the "Set raw value" column in the row for calibration point 2.

8. Remove the calibration weight.

9. If you have defined further calibration points, repeat steps 5 to 8 with these points.

10. Click on "Calibrate" to complete the calibration process.

11. Close the dialog.
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3.3.4 Changing the node ID

Please refer to the enclosed wiring diagram for information on the devices' CAN
addresses. Assign the CAN addresses in accordance with the wiring diagram.

1. On the IO cards to be assigned, check to which CAN ID the rotary switch of each
card is set (in the control box).

2. Open the context menu by right-clicking on the IO card (top level) and click on "Bus
node settings...".

This opens a new dialog.

3. In the first tab, click on "Change..." next to "Node ID". 

4. Select the new node ID and click on "OK".
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5. Confirm the prompt for confirmation.

6. Click on "Close" to close the dialog.

7. Click on the button "Restart application" to accept the settings.  
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3.3.5 Importing a wiring diagram

Wiring diagrams can be loaded in CSV format.

1. Click on the arrow pointing downwards next to the button "Default mapping" in the
lower bar. 

This opens a context menu.

2. Select "Load control cabinet mapping".

3.3.6 Creating a valve matrix

The digital modules BDDIO32 and BDDIO32LC can control the feed valves. In total, 32
channels are available, and the IO Manager can be used to configure each channel as
either input or output. The outputs can be switched to either +24 V or to GND,
depending on the configuration. This makes it possible to realise a valve matrix for the
actuation of the feed valves. A valve matrix can control a maximum of 220 valves per
digital module. 

1. Select the "Matrix to channel" tab in the upper area.

The application window is divided into matrix (on the left) and channel (on the right).
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2. In the matrix area, click on "Add". 

This opens the dialog window "Matrix".

3. Define the matrix and generate the matrix dimension based on the feed valves to
be controlled:

– "Type": Valve matrix

– "Name" of the valve matrix: freely selectable

– "Dimensions" > "Group": 5 (exemplary value) 

– "Dimensions" > "Single": 10 (usually matrices of 10)
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4. Accept these inputs by clicking on "OK".

The group outputs and the single outputs are shown on the left in the area "Matrix". 

5. Define the outputs +24 V and GND on the right in the area "Channel". Potentials
for the group outputs and single outputs must be opposed. 

a) Select one input or select multiple inputs by holding the Ctrl key.

Multiple editing is only possible for channels of the same type.

b) Right-click into the marked area.

c) In the context menu, select "Switch to output" > "HighSide", if the new output
should switch to high side (24 V).

OR:

In the context menu, select "Switch to output" > "LowSide", if the new output
should switch to low side (ground).

6. Link the group outputs and single outputs in the area "Matrix" with the
corresponding outputs in the area "Channel":

a) Create each link individually, see point 2, chapter 3.3.2 ”Creating links”.

OR:

Use multiple linking by clicking on the matrix icon and dragging it to the first
linking icon of the corresponding output group.
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The links are thus created all at once, one after another.    

7. Click on "Save" in the lower command bar to save the settings. 
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8. Define the valve link:

a) Click on "Valve link" in the upper command bar.

This opens the dialog window "Valve link".

b) Assign the valves in the column "Matrix" to the created matrix by clicking into
the input field and selecting the correct matrix.

c) As soon as you have assigned the first valve to a matrix, you can multi-edit the
other valves:

Right-click on the selected matrix to open the context menu and select "Copy
matrix to all valves in circuit".   
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d) Assign the valves in the column "Group" to one each of the created group
outputs:

Click into the input field and enter the number using your keyboard. 

OR:

Click on the arrow pointing downwards and select the number from the list.

e) Assign the valves in the column "Single" to one each of the created single
outputs:

Click into the input field and enter the number using your keyboard. 

OR:

Click on the arrow pointing downwards and select the number from the list.

9. Click on "Save" to save all settings.
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3.3.7 Creating a sensor matrix

In case of sensor feeding, the sensor installed in the trough reports whether the trough
is empty or not empty. You can create a sensor matrix to read the sensor inputs.

1. Select the "Matrix to channel" tab in the upper area.

The application window is divided into matrix (on the left) and channel (on the right).

2. In the matrix area, click on "Add". 

This opens the dialog window "Matrix".

3. Define the matrix and generate the matrix dimension based on the sensor inputs
to be read:

– "Type": Sensor matrix

– "Name" of the sensor matrix: freely selectable
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– "Dimensions" > "Group": 5 (exemplary value) 

– "Dimensions" > "Input": 10 (usually matrices of 10)

4. Accept these inputs by clicking on "OK".

The group outputs and the sensor inputs are shown on the left in the area "Matrix". 

5. Define the outputs +24 V for the groups on the right in the area "Channel". 

a) Select one input or select multiple inputs by holding the Ctrl key.

Multiple editing is only possible for channels of the same type.

b) Right-click into the marked area.

c) Select "Switch to output" > "HighSide" (+24 V) in the context menu.

6. Change existing outputs to inputs in the "Channel" area, where necessary.

a) Select one output or select multiple outputs by holding the Ctrl key.

Multiple editing is only possible for channels of the same type.

b) Right-click into the marked area.

c) Select "Switch to input" in the context menu.
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7. Link the group outputs and the sensor inputs with the corresponding channels in
the area "Matrix".

a) Create each link individually, see point 2, chapter 3.3.2 ”Creating links”.

OR:

Use multiple linking by clicking on the matrix icon and dragging it to the first
linking icon of the corresponding channel group.

The links are thus created all at once, one after another.    
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8. Click on "Save" in the lower command bar to save the settings. 

9. Define the valve link:

a) Click on "Valve link" in the upper command bar.

This opens the dialog window "Valve link".

b) Assign the sensors in the column "Matrix" to the created matrix by clicking into
the input field and selecting the correct matrix.
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c) As soon as you have assigned the first sensor to a matrix, you can multi-edit
the other sensors:

Right-click on the selected matrix to open the context menu and select "Copy
matrix to all sensors in circuit".   

d) Assign the sensors in the column "Group" to one each of the created group
outputs:

Click into the input field and enter the number using your keyboard. 

OR:

Click on the arrow pointing downwards and select the number from the list.
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e) Assign the sensors in the column "Sensor input" to one each of the created
sensor inputs:

Click into the input field and enter the number using your keyboard. 

OR:

Click on the arrow pointing downwards and select the number from the list.

10. Click on "Save" to save all settings.

3.3.8 Using the test mode

In the test mode of the IO Manager, all devices can be turned on and off to check the
correct setup of the control before starting to operate the system. 

CAUTION!

Only service technicians may use the test mode. Devices may start in case the system
is connected. Make sure that no persons or animals are located in or around the station
while using the test mode.

Deactivate the test mode when finished.

1. Click on "Start test mode" in the upper bar.



Page 76 Configuration of the system

CulinaMixpro
Edition: 12/2024      99-94-0696 GB 

2. In the "Device" part of the window, double-click on the interface of the device you
want to turn on .

The linked channel is marked accordingly.

3. Click on the check boxes of the selected device and respective channel to activate
them. 

The actual device is now turned on.

If the actual device does not turn on or if another actual device is running instead,
correct the links in the IO Manager or reconnect the outputs of the IO card. Always
refer to the overview drawing of the IO card attached to the wiring diagram.

4. Turn off the device by deactivating the check box.

5. End the test mode by clicking on  in the upper bar.

3.4 Manually controlling the system components

The system can be controlled manually in the "View" window after you have created
the image in the FeedMove Editor (chapter 3.2). You may manually control the
CulinaFlex system via the image by activating or deactivating individual system
components.

NOTICE!

Manual control of system components is done at your own risk and you are liable for
any subsequent damage. The control software (application) no longer operates the
system when using manual control! 

1. Click on the controller icon  of the respective system application in the farm
structure.
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2. Under "View", click on "Manual".
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NOTICE!

Check whether the system is running. Stop the system by clicking on  in the
upper bar. 

3. If necessary, adjust the view or retrieve one of your saved views using the camera
icons, see chapter 3.2.4.

4. You can manually switch on or off functions of the system components as follows: 

a) Click on the respective system component.

The colour of the system component changes to orange. The elements
belonging to this component are displayed in the window to the left. 
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b) Activate or deactivate the required element in the window to the left or by
clicking directly on the element icon in the view.

Active elements are orange. Inactive elements are gray. 

c) If you want to open or close a specific valve in a circuit, select the respective
valve using the arrows pointing up and down.

The selected valve is shown in the selected feed circuit in the view.



Page 80 Configuration of the system

CulinaMixpro
Edition: 12/2024      99-94-0696 GB 

5. Change the frequency of a system component that is controlled by a frequency
inverter, e.g. an agitator or a pump, if necessary. 

Click on the respective system component and change the frequency using the
arrows pointing upwards and downwards. 

6. Move the mouse pointer over the different icons in the depiction to see the full
name of the function or the system component. 

A tooltip shows the full name. 

7. Stop manual control by clicking on "Manual" again.
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3.5 Manual actions for the feed moves

As soon as you have created your system in the FeedMove Editor (see chapter 3.2),
the tab "View" is added to the application window. 

The system usually runs automatically, based on the configured settings. However, you
may access individual feed moves and carry out manual actions, e.g. pump the
contents of a mixing tank to the slurry tank or move a cleaning agent into a mixing tank.
Manual actions can also be defined for multiple feed moves. These actions are then
carried out one after another in the desired order.

1. Click on the controller icon  of the respective system application in the farm
structure.

NOTICE!

Check whether the system is running. Stop the system by clicking on  in the
upper bar. 

2. Click on the "Action" button in the "Equipment" or "View" tab.

This opens the dialog window "Manual action". 
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3. In the upper area, enter the "Source" and the "Target" of the respective feed move
and select the feed move from the list.

4. In the central area under "End condition", "Pump" and "Agitator speed", configure
the temporary settings.

Depending on the feed move and the installed system components, the
corresponding parameters for the action become active, for example:

– "Weight" only applies if the source or the target of the feed move has a scale.

– "Sensor is activated" only applies if the source of the feed move has a minimum
sensor or if the target of the feed move has a maximum sensor.

– The button "<= Until minimum weight" is the value of the parameter "Min.
amount" for each tank, e.g. mixing tank. This value is entered in the application
settings, see chapter 7 ”CulinaMixpro settings”, page 113.

If you click on this button, the system turns off as soon as the minimum weight
has been reached.

– "Empty completely" simplifies specifying the end condition when processing
several actions for interdependent feed moves.

If you check this box, the system turns off as soon as the respective tank, e.g.
mixing tank, has been completely emptied.
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5. Click on "Add" in the lower area to add the feed move with the defined action to the
field on the right.

If you add more feed moves with a defined action to the field, you can use the
arrows pointing upwards and downwards to determine the order in which the
actions are processed.

6. Check the box "Highlight focused feed move" in the lower command bar if you want
the selected feed move to be highlighted in colour in the "View" tab.

7. Click on "Save" in the lower command bar if you want to save the actions listed in
the field as a template for later reuse or for use as a strategy within the Task
Manager (see chapter 8.1.8 ”Strategy: Manual action”, page 171).

Under "Patterns", you can open previously saved action templates for editing or to
rename, copy or delete them.

8. Click on "Start" in the lower command bar to start the action(s).

9. Click on "Close" in the lower command bar to close the dialog window.   
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3.6 Editing a user-defined label

If you have defined "Label for user-defined text" in the Composer (see chapter 3.1.1.3
”Accessories”, page 31), open the edit window for the user-defined label under "View"
by right-clicking on the corresponding icon or on the label and then clicking on "Info
text".

In the edit window, edit the label and the info text of the user-defined label and confirm
by clicking on "Save".

As soon as an info text has been entered and saved, the info text is displayed as a label
under "View".
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3.7 Stopping the system and canceling an action

You may stop the system during operation by clicking on "Stop" in the upper bar in the
tabs "View" or "Equipment". If you click on "Start" again, the system continues to
operate with the current action or task. 

However, if you do not want to continue the current action, start the system again as
follows:

1. Click on the arrow pointing downwards next to the "Start" button and select the
correct option from the context menu.

– Start with canceling current action: The system starts, cancels the current
action and continues with the next action.

– Start with canceling the feeding time: The system starts and cancels the
current task, e.g. feeding or cleaning.

Only available if the system only has one mixing tank.

– Restore control process: In case of control errors of the BigFarmNet
Manager, use this option to restart the entire system including all processes.

– Start with new mixture: The system starts and mixes a new recipe. A dialog
to indicate the amount opens.

Only available in the "Equipment" tab and if only one mixing tank is installed.
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3.8 Stopping the mixing tank and canceling an action

The mixing tanks are displayed in the "Equipment" tab based on the configured system.
The mixing tanks are sub-applications. The graphical depiction provides the following
information, for example:

• current action of the mixing tank;

• current temperatures for mixing in the mixing tank (T), for the heat exchanger (E)
and for distribution (D);

• current pressure in the pipelines;

• "Content" shows the components in the mixing tank, including their amount. For
water, no difference is made between warm and cold;

• "Preparation" shows the current preparation, including information on the currently
available amount and the missing amount of the components.

If there is more than one mixing tank, you can stop each mixing tank individually during
operation by clicking on the corresponding stop button. If you click on the
corresponding "Start" button, the mixing tank continues to operate with the current
action.

However, if you do not want to continue the current action, start the mixing tank as
follows:

1. Click on the arrow pointing downwards next to the start button and select the
correct option from the context menu.
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– Start with canceling current action: The mixing tank starts, cancels the
current action and continues with the next action defined in the Task Manager.

– Start with reset total feeding time: The mixing tank starts and cancels the
current task, e.g. feeding or cleaning.   

– Start with new mixture: The mixing tank starts and mixes a new recipe. A
dialog to indicate the amount opens. 
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3.9 Mixing tank monitoring

The tab "Mixing tank monitoring" indicates the contents of each tank for the past 24
hours. The diagram shows at which times of the day weight changes occurred. 

Click into the diagram to change the 24-hour view with the scroll wheel of your mouse
(see longer or shorter periods). The timeline changes accordingly. 
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3.10 Subcircuit overview

You can lock circuits and valves under the tab "Subcircuit overview". Parameters with
the pen icon  can be edited: 

• In the upper part, you can lock an entire circuit directly if you do not want it to supply
feed or if the corresponding section is empty.

Marked a circuit by clicking to view all corresponding valves in the lower part of the
window. Lock individual valves of a circuit, for example if some pens are not
occupied. 

• Define the correct feed curve and the animals' age based on the curve day.

The "Valves" parameter shows 

• the total number of connected valves at the first position ("total"); 

• the number of active valves at the second position ("active); 

• the number of active valves with the status "Empty" at the third position ("empty"). 
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3.11 Mixing tank history

The "Mixing tank history" tab shows a log for each individual action of each mixing tank.
This makes it easy to identify unusual actions. 

3.12 NetFEED

NetFEED is an optional function that allows you to establish app connections between
system applications within a farm. For example, an application's mixing tank can also
serve other applications on the farm, provided you have assigned the applications to
the same NetFEED group.
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You can configure the settings for the NetFEED groups as follows:

1. Click on "Settings NetFEED groups" in the "Setup" menu.

2. Click on "Manage NetFEED groups...".

3. Click on "Add", enter the group name and click on "OK" to create a new group.

4. Click on "Close".

5. Select a joint group for the applications to be connected under "NetFEED group".
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6. Under "Application connections", assign the desired incoming app connection of an
application to the outgoing app connections of another application.

7. Click on "Save".

You can configure further NetFEED settings under "Settings" > "General" >
"Application settings" > "NetFEED" (see chapter 7.2.3 ”Application settings”, page
119).
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To access the options for controlling a NetFEED group, proceed as follows:

1. Click on the controller icon  of the respective system application in the farm
structure.

2. Click on "NetFEED group".
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4 Feed curve
To meet the feed demand of the animals, use a feed curve to define which feed
components are dispensed at which ratio and during which time periods. Daily rations
are adapted automatically as required by the individual growth states. 

Before you define a feed curve, you need to determine (feed) components as well as
nutrients as required. 

4.1 Creating nutrients

Nutrients include carbohydrates, fats and proteins, but also vitamins and minerals. The
nutrients you create determine the nutritional value of the components. When you
create a new component, all nutrients you created before will be listed. You can then
enter the corresponding values per component, see chapter 4.2 ”Creating
components”.

1. In the menu "Configuration" > "General", click on "Nutrients".

2. In the dialog window "Nutrients", click on "Add".

3. Enter a name for the nutrient and determine the unit.



Feed curve  Page 95

CulinaMixpro
Edition: 12/2024     99-94-0696 GB 

4. As an option, you can also determine a priority for each nutrient. The nutrients can
then be listed in ascending or descending order according to priority later on.    

5. Accept these inputs by clicking on "OK".

4.2 Creating components

Use the "Component" dialog to create different components and to configure different
settings depending on the application. Components are assigned to different
categories. Components in the category "Feed" can be the individual ingredient of a
feed mix or a complete compound feed.

1. In the menu "Configuration" > "General", click on "Components".

2. In the dialog window "Components", click on "Add".

3. Enter a name for the component and select a category.
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4. Under the tab "Nutrient content", define the dry matter fraction.

5. Only after entering the dry matter fraction can you choose one of the following
quantities: 

– FM = per fresh matter

– DM 88 % = in relation to 88 % dry matter

– DM 100 % = in relation to 100 % dry matter

If required, enter the energy content and the individual nutrient fractions in the table
below (see 4.1 ”Creating nutrients”).

6. Define parameters for feed preparation in the mixing tank under the tab "Technical
settings".
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– Under Total mixing time, determine a time period for mixing the component.
If several components are mixed together, the mixing time will correspond to
that of the component with the longest mixing time.

If a component needs to macerate first, click on Interval mixing and enter the
required value.

– If the silo from which the component is removed has a vibrator, you can
configure the corresponding settings using the following parameters:

If the box Always use vibrator is checked, the vibrator is always and
constantly used during removal from the silo. If the box is not checked, the
vibrator is only activated if the control system determines that too little of the
component reaches the target (e.g. mixing tank) during removal. This is the
case if feed bridging occurred in the silo, which can block removal from a silo
even though it is not empty. Such bridging can be solved by using a vibrator. If
the vibrator is successful, it is switched off and removal from the silo continues.
If the vibrator is not successful, the control system switches to another silo with
the same component or to a replacement component. If this is not possible
either, an alarm is generated.

If the box Vibrator interval mode is checked, the silo vibrates at intervals, i.e.
a vibrator active time (silo vibrates) and a vibrator pause time (silo does not
vibrate) alternate. If this box is not checked, the vibrator is active constantly.
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– Define settings for dosing of the component:

Auto: Define a weight as threshold value. If the weight of the dispensed
component is below the threshold, dosing is automatically time-controlled. If
the weight is above the threshold, dosing is automatically weight-controlled.

OR

Manual: Define whether components should generally be dispensed "by
weight" or "by time".

– If the component is dissolved in water, change the presetting under Specific
weight, if necessary.

7. Select one or more replacement components from the tab "Replacement
components" in case the component you entered is used up before a new order
arrives. If you select more than one replacement component, you may sort them in
descending order according to priority. 

8. Configure the necessary settings under the tab "Inline milling settings".

These settings refer to components that are produced by a milling method while a
mill carries out a feed move. The base component is the source component from
which the component is produced through the milling method. A milling method
can be assigned to a mill's feed move, which means that executing this feed move
produces the component from a base component. The auger start speed and the
auger maximum speed indicate the start and maximum speeds for controlling the
source silo's discharging auger.
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Since CulinaFlex is not equipped with a mill, these settings only play a role if a feed
move from a HydroMixpro system to a CulinaMixpro system is executed by a mill
for a NetFEED system.

9. Configure the necessary settings under the tab "Liquid feeding settings". 
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– Liquid feeding technical settings:

Waiting after mixing tank agitator on/off: Time period for which the system
should wait with preparation before dispensing the next component in case the
agitator was active for the previous component and should not be active for the
next component, or in case the agitator was not active for the previous
component and should be active for the next component. During this time
period, the mixing tank's scale can settle after switching the agitator on or off.

Dosing with agitator of mixing tank: The agitator in the mixing tank should
run while the component is dispensed into the mixing tank.

(Dose component through circuit: no function.)

(Preferred feed pump type: no function.)

– (Parameters for usage as additives: no function.)

– In the area Parameters for dosing into mixing tank, the temperature values
to be defined are target values. The parameter Additional mixing time after
dosing ensures that the component can dissolve at the stated temperature. If
a time longer than "0 min" is set for the parameter Maximum waiting time for
preparation and neither the component nor a replacement component are
available, preparation waits for a maximum of this time. You may also stop the
waiting time earlier. After the waiting period has ended, preparation continues.
If the component or a replacement component are still not available at this
time, preparation stops with an alarm.

10. Define the values for the agitator during distribution under the tab "Culina settings":

– If the box Interval mixing during distribution is not checked, the agitator will
mix permanently.

The system uses the longest mixing time and the shortest pause time when mixing
multiple components. 
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11. Define a color for the component under the tab "Color". 

If you do not define a color, the system will assign a color automatically. The color
will help you differentiate between components in diagrams, e.g. when you create
feed curves or recipes or when analyses are prepared.

12. Click on "OK" after you have configured all settings.

4.3 Defining a feed curve

1. In the menu "Configuration" > "General", click on "Feed curves".

2. In the next dialog window, click on "Add".

You can edit, copy or remove created feed curves later on, if necessary.
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3. In the next window, select the feed curve type "Piglet – CulinaMixPro liquid feeding"
and enter a name for the feed curve.

The unit type is set to "Fresh matter" automatically.

4. Click on "Next".

5. From the component list in the upper left-hand part of the window, select the dry
components for your feed curve either by double-clicking on the component in the
list or by clicking on the arrow pointing to the right. 

6. If necessary, define an order for the components.

By default, the function "Automatic mixing order of the components" is active
(button highlighted in gray). This means that the component with the largest
fraction always enters the mixing tank first. Click on the button to deactivate the
function and to define a different order using the arrows.
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7. Click on "Next".

8. Define the feed curve under the tab "Envelope curve".

a) Enter values for the following parameters in the input fields below the table:
(Curve) Day, Feed temperature (distribution temperature), Preparation
amount for each mixture plus pipe content (amount that is actually supplied to
the animals). 

b) Press Enter after you have determined a time period for the curve.

c) Continue by entering further curve days.

The curve in the diagram will take shape the more curve days you enter.

9. Click on "Next" after you have completed all inputs. 
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10. Define the percentage share of the different components for one curve period
under "Feed composition". The fractions always add up to 100 %.

a) Click on the desired curve day in the list.

You can also edit multiple curve days at the same time: Press and hold down
the Ctrl key. Click on all curve days that should have the same percentage.

b) Enter the percentage directly into the input field under "Fixed ingredient
fraction". 

OR:

Use the colored line to change the value. Click on the dot and hold the mouse
button. Use the mouse to adjust the length of the colored line and thus the
percentage. 

c) If there are more than two components, click on the padlock icon to fix
fractions. Such locked values will not change when defining further fractions. 

11. Under the tab "Mixing ratio", define the dry matter (feed) and water percentages for
the corresponding curve period.

a) Click on the desired curve day in the table.

You can also edit multiple curve days at the same time: Press and hold down
the Ctrl key. Click on all curve days that should have the same percentage.

b) Enter the minimum dry matter percentage (Min DM) into the input field below
the respective column. 
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c) Enter the density into the input field below the respective column, if necessary.

d) In the pane "Dry matter percentage", enter either the value for dry matter or for
water.

The other value and the ratio are calculated automatically.
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12. Click on "Next" to move to the "Overview" tab.

This tab shows a summary of the feed curve you created. Use the overview to
verify your settings. It is, however, not possible to make any changes here.

Click on the individual curve days to see the corresponding information in the
"Fractions" window, and the nutritional values under the "Nutrition" tab.

13. Click on "Save" to save all settings.
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5 Cleaning components

5.1 Creating an acid / a lye

Acids and lyes are treated separately in BigFarmNet Manager. However, menu
navigation for adding acids and lyes is identical. The following instructions explain how
to create an acid as an example. 

1. In the menu "Configuration" > "Cleaning", click on "Acids".

2. In the next dialog window, click on "Add".

3. Enter a name for the acid and activate the option that the acid may be used in feed
curves by checking the box, if necessary. This option does not exist for lyes and is
therefore not displayed in the corresponding dialog!

4. Define parameters for feed preparation in the mixing tank under the tab "Technical
settings".
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– Under Total mixing time, define a duration for mixing of the acid. 

– Select the Dosing type, either "by weight" or "by time".

5. Under the tab "Liquid feeding settings", define whether the agitator should be
running while dispensing the acid/lye into the mixing tank during preparation. 

6. Define the values for the agitator during distribution under the tab "Culina settings":

– If the box Interval mixing during distribution is not checked, the agitator will
mix permanently.

7. Select a color for the acid under the tab "Color".
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8. Click on "OK" after you have configured all settings.

5.2 Creating a cleaning recipe

Use the acids and lyes you have set up to create a recipe for cleaning. Observe the
instructions on the packaging of the cleaning component, e.g. regarding temperature.
Recipes for cleaning are used in the task "Circuit cleaning according to a recipe", for
example, see chapter 8.1.5. 

1. In the menu "Configuration" > "Cleaning", click on "Recipes".

2. In the dialog window "Cleaning recipe", click on "Add".

3. Enter a name for the recipe.

4. Add the correct cleaning component under the first tab "Cleaners".

5. Define the mixing ratio between the cleaning component and water:

a) Click on the tab "Total mixture", and in the lower part of the window on the tab
"Water ratio". 

b) Enter the amount of the cleaning component. 

The ratio is calculated automatically and the percentages are indicated in the
upper part of the window, also automatically. 
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6. In the lower part of the window, define the temperature of the mixture under "Liquid
feeding settings". 

7. Click on "OK" after you have configured all settings.
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6 Container chains
The sequence of containers (silos and/or pre-mixing tanks) from which components are
removed can be configured using so-called container chains. 

It is advisable to include only containers with the same component and priority in a
container chain. However, a container chain may also include containers with different
components and priorities.

Container chains belong to the application or to the NetFEED group to which the
application belongs. They are only created once for every NetFEED group. All silos and
pre-mixing units of all NetFEED group applications can be selected. If an application is
not part of a NetFEED group, only the silos and pre-mixing tanks of the application can
be selected.

After configuring the container chains, their priority can be adjusted (see chapter 7.8.4
”Priority of container chains”, page 156).

1. In the menu "Configuration" > "General", click on "Container chains".

2. In the dialog window "Container chains", click on "Add".

3. Enter a name for the container chain.
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4. From the top list of containers that can be added, select the desired containers and
click on "Add" to add them to the container chain below.

5. Sort the containers within the container chain using the arrows pointing upwards
and downwards.

6. Confirm the container chain by clicking on "OK".

The containers that were listed from top to bottom during configuration of the
container chain are listed from left to right in the "Container list" column of the
"Container chains" dialog window.

7. Configure additional container chains, if required.

8. Confirm the container chains by clicking on "Close".
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7 CulinaMixpro settings
Settings for the application are configured under the "Equipment” tab. Parameter
values can be changed as necessary at any time to meet individual requirements. 

Open the setting parameters as follows: 

1. Click on the controller icon  of the respective system application in the farm
structure.

NOTICE!

Check whether the system is running. Stop the system by clicking on  in the
upper bar. 

2. Under "Equipment", click on "Settings...".

This opens the settings dialog, which contains all settings for the system
components you defined in the Composer beforehand. The settings are grouped
and may have pre-set values. The different parameters are described in the
following chapters.

Only save after you have defined all settings of the tabs. The "Save" function
affects the entire settings dialog. Saved changes are immediately applied to the
system(s)!
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NOTICE!

Tooltips available! Move the mouse pointer over the input fields or the parameters in
the head line to see a more detailed description. 

7.1 Copying the settings of a system 

If multiple systems (applications) of the same type are to be configured with the same
settings, you can define the settings for one system and copy them to other systems.
The copy function is permanently available in the settings dialog. It can only be used
for the settings of the currently active tab.

Proceed as follows:

1. Configure the settings for one system.

2. Click on the button "Copy Settings..." in the top part of the window. 
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3. In the next dialog window, select the system whose settings you want to copy.

4. Click on "Next".

5. Select all systems to which you want to transfer these settings in the next dialog
window.

6. Click on "Copy". The settings are now transferred to all selected systems.
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7.2 General

7.2.1 Feed preparation (general)

The "Feed preparation" dialog is divided into 2 areas, which are explained below.

1. Basic settings

• Max. dry matter: If this value is exceeded during filling of the mixing tank, an
alarm is generated.

• Agitator slow before off: When a component is conveyed into a mixing tank
or a pre-mixing tank while the agitator is running, the agitator mixes quickly at
first. As soon as the remaining amount that still needs to be dispensed
corresponds to this value, the agitator switches to a slower mode. If the value
is greater than the total amount, the agitator mixes slowly from the beginning.

• Warning dry matter percentage: If the desired dry matter percentage cannot
be achieved, a warning is generated.

• Cleaning amount at end of preparation: If water is used as replacement
component, this proportion of water is dispensed by the cleaning valve after
preparation. Prerequisite: The amount is greater than the minimum amount set
under "Min. cleaning amount at end of preparation".

• Min. cleaning amount at end of preparation: If the calculated percentage
"Cleaning amount at end of preparation" is below this value, no water is
dispensed by the cleaning valve after preparation.

• Allowed temperature difference: Permitted temperature difference after
preparation if a target temperature of > 0 °C or > 32 °F is set in recipes, pre-
mix recipes or feed curves.
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• Adjustment water at start: Proportion of the water used at the start in relation
to the total amount of water. With the remaining proportion, the target
temperature of the mixture can be reached after all components have been
dispensed. (Only when preparing with a target temperature.)

• Water via cleaning valve: If this box is checked, fresh water is added via the
cleaning valve (the box is not checked by default!).

• Max. temperature deviation (cold water): Maximum temperature deviation
during preparation when dispensing cold water into the mixing tank. The lower
the value, the more frequently the system switches between cold and warm
water.

• Prohibited to use used water for preparation: The preparation process only
uses sufficient used water to leave enough water for pushing.

• Dry matter for extra adjustment (% of max. DM): If the calculated dry matter
content exceeds this value after dispensing a component via the circuits, water
is dispensed directly into the mixing tank to achieve the desired dry matter
content. "0.0 %" means that no such adjustment is made.

• Use replacement if sub-application of silo goes out of operation while
dosing: If the sub-application of a silo stops operating while dispensing a
prepared mixture from the silo, the prepared amount is not stopped with an
alarm, but switches to another tank with the same component or to a
replacement component.

2. pH levelling

• Setting time: Time to level the pH value after dispensing into the mixing tank.

• Dosing time: Time for dispensing the component to level the pH value in the
mixing tank.

• Number of tries: Maximum number of attempts to level the pH value in the
mixing tank.

• Ingredient: The component used for levelling.

• pH alarm level: Action if the pH level in the mixing tank has not been reached
after the maximum number of dispensing attempts ("No" = no action, "Warning"
= warning is generated, "Alarm" = alarm is generated).
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7.2.2 Piglet settings

The "Piglet settings" dialog is divided into 2 areas, which are explained below.

1. General

• Max. open valves: Number of valves that are open at the same time

• Minimum time for emptying main and subcircuits: Based on the filling time.

• Percentage to water pipe content: After feeding has been completed, water
is pumped into the mixing tank until the set percentage has been reached. The
standard feed preparation amount is the basis for this percentage. This
parameter is only applicable if a time was set under "Water prepare time" in the
feeding task. The parameter is used for cleaning with water.

2. Assignment: Use the curve days to define the order of the mixing tanks that are
used to feed piglets of different ages here.

• Mixing tank used for young piglets: Selection of the mixing tank with the
feed for young piglets.

• Curve day threshold for young piglets: Feed is taken from the "Mixing tank
used for young piglets" until the curve day entered here.
This means that piglets that are younger or of the same age as the indicated
curve day receive feed from the "Mixing tank for young piglets".

• Mixing tank used for middle-aged piglets: Selection of the mixing tank with
the feed for middle-aged piglets.

• Curve day threshold for middle-aged piglets: Feed is taken from the "Mixing
tank used for middle-aged piglets" until the curve day entered here.
This means that piglets that are younger or of the same age as the indicated
curve day receive feed from the "Mixing tank for middle-aged piglets".
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• Mixing tank used for older piglets: Mixing tank with feed for older piglets. 
After selecting the other two tanks, this mixing tank is assigned automatically.

7.2.3 Application settings

The "Application settings" dialog is divided into 7 areas, which are explained below.

1. Application not operational

• Action after max. pause time: Action after the time set under "Max. pause
time" has elapsed ("Alarm" = alarm is generated, "No" = no action, "Warning"
= warning is generated).

• Max. pause time: If the application does not run for a time longer than
specified here (pause or error), the action set under "Action after max. pause
time" is carried out. When "0 min" is set, there is no maximum pause time.

• Repeat action: The action set under "Action after max. pause time" is
repeated each time the time set under "Max. pause time" elapses.

• (Global "Application not operational" alarm: No function.)

2. Resources

• Resource request timeout: Waiting time after which an alarm is generated if,
for example, a component of an external system cannot be accessed.

3. NetFEED



Page 120 CulinaMixpro settings

CulinaMixpro
Edition: 12/2024      99-94-0696 GB 

• Application for external order: Application for the external order.

• Preferred feed pump: Preferred feed pump for transporting the liquid feed
between applications. (Only if the supplying application has two different feed
pumps.)

• Mixing tank for external order: Fixed assignment of the mixing tank for an
external order.

• Application for external cleaning order: Assigned application for which an
external cleaning order can be requested.

• Cleaning tank for external order: Cleaning tank in which an external order is
to be prepared. If not specified, any mixing tank is used.

• Max. waiting time for external order: Maximum waiting time for an external
order.

• Maximum waiting time for external cleaning order: Maximum waiting time
for an external cleaning order.

• Number of preorders (only valid for HydroMixPro): Maximum number of pre-
orders of the ordering application.

• Use used water tank in external order: Enables the external application to
access the used water tank of the ordering application.

4. Warnings

• Generate warnings if device is not linked: When the software is restarted, a
warning is generated if devices are not connected in the IO Manager.

5. Swap tank

• Use swap tank mode: The mixing tank and the used water tank are
automatically exchanged for preparation based on the tank contents.
Components must be available in both tanks.

6. UI

• Update rate UI: Time after which the display of the amount change is updated
during feed moves (e.g. amount of a component currently added during
preparation). When "0.0 s" is set, any change is displayed.

• Feeding screen on 510 active: Displays the animal management on the 510
controller.
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7. Reset

CAUTION!

Risk of data loss!

All settings are deleted and cannot be restored! 

• Reset application: Triggers a "hard reset". All active tasks are canceled and
the controller is restarted. Afterwards, manual intervention may be necessary,
e.g. when feed remains in the pipes.

7.2.4 User acknowledgement

• User acknowledgement alarm level: Action when thre is no user
acknowledgement within the period set under "Timeout" ("Alarm" = alarm is
generated, "No" = no action, "Warning" = warning is generated).

• Timeout: Maximum waiting time for a user acknowledgement. Once this time has
elapsed, the action set under "User acknowledgement alarm level" is performed.

• Repeat alarm: The action set under "User acknowledgement alarm level" is
repeated each time the time set under "Timeout" elapses.

7.2.5 Water settings 
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• Dosing with agitator of mixing tank: 
Use this setting to define whether the system uses water for mixing, e.g. when cold
and warm water are used to regulate the temperature in a specific way. 

• Wait after mixing tank agitator on/off: 
When the agitator is switched from "on" to "off" (and vice versa), the agitator waits
for the time indicated here before water is filled into the mixing tank.

7.2.6 Distribution (heat exchanger)

• Heat exchanger temperature tolerance

The temperature tolerance is a switching threshold for the heat exchanger. If the
feed temperature drops below this tolerance value, the heat exchanger is
activated.

• Always lock empty valves

If this box is checked, feed valves whose troughs have always reported "empty"
during feeding are locked.
Constant empty reports indicates an issue.
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• Allow pushing from mixing tank

If the used water tank runs empty when positioning the feed in the circuit and the
stop point has not yet been reached, the positioning of the feed from the mixing
tank is continued instead of retrieving the additional amount of pushing component
into the used water tank and continuing the positioning of the feed from there.

7.2.7 TroughCheck

Digital trough check

• Sensor request time

Time required to determine the trough status from the time the sensor is ready
for use.

• Sensor minimum empty time

Minimum time for which a sensor must report empty during the "Sensor request
time" for the sensor to be recognized as empty.

• Sensor initialize time

Time between activation of a trough sensor and the start of the time set under
"Sensor request time".
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7.2.8 Miscellaneous

The "Miscellaneous" dialog is divided into 10 areas, which are explained below.

1. Small circuit

• Max. recirculation time: Maximum time for recirculation in the small circuit.
The actual recirculation time results from this value and a percentage value of
a feeding or recirculation task in the Task Manager.

2. Content

• Content of pipes: Defines the contents in the pipes as water. This may be
necessary if the contents have become mixed up (manual intervention) or if
lines have been extended/changed (e.g. adjusted circuit lengths).

• Drain mix-up time: Mix-up time of the mixing tank contents

• before the contents are pumped into the used water tank at the beginning of
preparation,

• after the "Maximum waiting time" at the end of preparation has elapsed,

• after watering if the remaining amount in the mixing tank is used for watering
first,

• before the transfer of an external order,

• before distribution from a mixing tank starts.

3. Tank cleaning
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• Delay fogging and emptying: Time between two different fogging processes
(acid, lye).

• Clean all tanks after feeding: Not only the tanks used for feed preparation are
cleaned as part of a feeding task, but all selected tanks (to prevent an
accumulation of water in the pipes).

• Acid threshold for cleaning with lye: A cleaning programme with lye is not
started if the acid concentration in the pipes or in the mixing tanks exceeds this
value.

4. Feed phase

• Default feed phase: If the pigs have not been assigned a feed phase via the
feed curve, this feed phase is used instead. This feed phase defines all
necessary parameters.

5. Technical amount (only valid for HydroMixPro.)

• Technical amount warning: A warning is generated if it is necessary to mix
an additional amount of feed so the required feed can be dispensed correctly
at the valves used for feeding.

6. Pressure monitoring

• Max. allowed pressure: If the pressure in the pipes as determined by a
pressure sensor exceeds this value for the duration of the time set under "High
pressure monitoring time", the feed pump is switched off.

• High pressure monitoring time: If the value set under "Max. allowed
pressure" is exceeded for this time while a feed move is executed, the feed
move is stopped and an alarm is generated. When "0 s" is set, an alarm is
generated immediately upon exceeding this value.

• Critical pressure: If this value is exceeded, the system stops immediately.

7. Stirring between preparation and distribution (only valid for HydroMixPro)

• Mix state: Type of mixing ("Interval mixing", "Non-stop mixing", "Without
mixing").

• Speed: Speed of the agitator during the mixing interval ("Slow", "Fast").

• Interval mix time: Duration of the mixing phase between 2 pauses. (Only for
interval mixing.)
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• Interval pause time: Duration of the pause between 2 mixing phases. (Only
for interval mixing.)

8. Frequency inverter

• Gap target frequency reached: If a frequency inverter in the application does
not reach the target frequency within this time, a warning is generated. When
"0 s" is set, no warning is generated.

9.

• Bin usage check: Tank use is only permitted if the (sub-) application of the
tank is in operation.

10. Cleanup data

• Alarms and warnings: Alarms and warnings are deleted from the alarm log
after this time has elapsed.

• Scheduler data: Tasks are deleted from the Task Manager after this time has
elapsed.

7.2.9 Sub-application settings

• Name: Name of the sub-application.

• Activate sub-application: Activates the selected sub-application.

• Action after max. pause time: Action after the time set under "Max. pause time"
has elapsed ("Alarm" = alarm is generated, "No" = no action, "Warning" = warning
is generated).

• Max. pause time: If the sub-application does not run for longer than specified here
(pause or error), the action set under "Action after max. pause time" is carried out.
When "0 min" is set, there is no maximum pause time.

• Repeat action: The action set under "Action after max. pause time" is repeated
each time the time set under "Max. pause time" elapses.
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• Global "Application not operational" alarm: If "Action after max. pause time" is
set to "Alarm", this alarm is generated for the entire application. The application is
stopped, including all sub-applications.

• Resource request timeout: Waiting time after which an alarm is generated for the
sub-application if a component cannot be accessed because it is already being
used by another process.

7.2.10 Frequency transformer

• Name (only an information): Name of the frequency inverter.

• Location (only an information): Location of the frequency inverter on the farm.

• Pool pair number: Number of pole pairs of the frequency inverter. This value can
only be changed by a service technician when installing a different motor.

7.2.11 Sensor alignment

The "Sensor alignment" dialog is divided into 4 areas, which are explained below.

1.

• Path (only an information): Location or part of the system where the sensor is
installed.

• Sensor (only an information): Type of the sensor.
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• Alignment mode:

UseSensor (standard setting): The adjusted sensor value is based (with delay
times) on the actual sensor value.

Low: The adjusted value is always and constantly "Low".

High: The adjusted value is always and constantly "High".

"Low" and "High" can be useful temporarily if the sensor does not work and the
system cannot otherwise continue to run. The below settings are not relevant
for "Low" and "High".

2. In

• Delay high: Delay time at the input of the IO. The input must be activated at
least until the "High" signal is transmitted to the control system. The control
system does not respond to a "High" signal that is shorter than this time.

• Delay low: Delay time at the input of the IO. The input must be deactivated at
least until the "Low" signal is transmitted to the control system. The control
system does not react to a signal drop that is shorter than this time (e.g. if an
alarm sensor signal only drops for a short time).

3. Out

• Minimum high: The adjusted "High" signal remains "High" for at least this
period of time. (The standard setting is "0.0 s".)

• Minimum low: The adjusted "Low" signal remains "Low" for at least this period
of time. (The standard setting is "0.0 s".)

4.

• Invert sensor: The real signal is inverted before the adjustments are made.
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7.2.12 Warnings

The "Warnings" dialog is divided into 2 areas, which are explained below.

1.

• Path: Application for which the warnings set under "Disabled warnings" are
deactivated.

• Location: Location on the farm of the application for which the warnings set
under "Disabled warnings" are deactivated.

2. Disabled warnings

• Group: Superordinate groups to which the warnings set under "Type" belong.

• Type: Disabled warnings.

7.3 Component supply

The settings under "Component supply" are applicable for the following system
components:

• Silo (dry, liquid)

• Mineral dosing unit (dry, liquid)

• Pump

• Dosing auger

Setting parameters appear depending on the components that are part of your system
and that you configured in the Composer. In many cases, the same setting parameters
apply to different system components. 
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7.3.1 Silos

The "Silos" dialog is divided into 5 areas, which are explained below.

1.

• Name: Name of the silo.

• Location (only an information): Location of the silo on the farm.

2. General

• Mix-up time before dosing: Duration for which the silo contents are mixed
before the component is dispensed into the mixing tank or pre-mixing tank.
(Only for silos with agitator.)

• Mix-up speed: Speed of the agitator when mixing the silo contents before
dispensing. (Only for silos with agitator.)

On (fixed setting): Agitators with direct switch-on

Slow/Fast: Double-stage agitators with tapped winding or agitators with
frequency inverter

• Mix-up before pushing to stop point: The silo contents are mixed before
being pushed to the stop point. (Only for silos with agitator.)



CulinaMixpro settings  Page 131

CulinaMixpro
Edition: 12/2024     99-94-0696 GB 

• Agitator speed during removal: Speed of the agitator during removal from
the silo. (Only for silos with agitator.)

On/Off: Agitators with direct switch-on

Off/Slow/Fast: Double-stage agitators with tapped winding or agitators with
frequency inverter

• Agitator speed during filling: Speed of the agitator during filling of the silo.
(Only for silos with agitator.)

On/Off: Agitators with direct switch-on

Off/Slow/Fast: Double-stage agitators with tapped winding or agitators with
frequency inverter

• Recirculation time: Duration for recirculation in the liquid silo before the
component is dispensed into the mixing tank. (Only for liquid silos in which
recirculation is possible.)
If mixing is also planned for the liquid silo, the contents are recirculated after
mixing.

• Min. cleaning amount: Amount of cleaning component used for silo cleaning
if the specified amount for silo cleaning is less than this value. This amount is
used for rinsing the silo after fogging. If fogging was part of cleaning and
cleaning is canceled, the tank is still rinsed with this amount before the safety
switch is released.
This value should be smaller than the value set under "Max. amount".

• Min. clean time: Minimum duration of silo cleaning.

• Capacity: Capacity of the silo.

• Min. amount: Minimum amount that should remain in the silo during removal.
(Only for weighed silos.)

• Max. amount: Maximum filling amount of the silo.
This value should be greater than the value set under "Min. cleaning amount".

• Tank content: Displays and adjusts the silo contents.

• Warning if silo runs empty: Generates a warning if the silo runs empty during
removal.

3. Agitator (only for silos with agitator)
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• Error/Pause state: Speed of the agitator in the event of an error or during a
pause.

On/Off: Agitators with direct switch-on

Off/Slow/Fast: Double-stage agitators with tapped winding or agitators with
frequency inverter

• Deviation: The speed of the agitator is maintained for as long as the weight
does not deviate by more than this value from a supporting point of the
agitation curve. (Only for agitators in weighed silos and with an agitation curve
already created.)

• Min. speed: Minimum frequency of the agitator. (Only for agitators with
frequency inverter.)
If the silo is not weighed, the minimum frequency is used for slow mixing.

• Max. speed: Maximum frequency of the agitator. (Only for agitators with
frequency inverter.)
If the silo is not weighed, the maximum frequency is used for fast mixing.

• Delay from slow to fast: Delay time when switching from slow mixing to fast
mixing. (Only double-stage agitators with tapped winding.)

• Delay from fast to slow: Delay time when switching from fast mixing to slow
mixing. (Only double-stage agitators with tapped winding.)

4. Fast curve (only for silos with agitator)

• Fill amount: Setting of the fast agitation curve. From this amount in the silo,
the agitator runs at the speed set under "Speed".

• Speed: Setting of the fast agitation curve. From the amount set under "Fill
amount" in the silo, the agitator runs at this speed.

5. Slow curve (only for silos with double-stage agitator with tapped winding or
agitator with frequency inverter)

• Fill amount: Setting of the slow agitation curve. From this amount in the silo,
the agitator runs at the speed set under "Speed".

• Speed: Setting of the slow agitation curve. From the amount set under "Fill
amount" in the silo, the agitator runs at this speed.
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7.3.2 Mineral dosing unit

The "Mineral dosing units" dialog is divided into 4 areas, which are explained below.

1.

• Name: Name of the mineral dosing unit.

• Location (only an information): Location of the mineral dosing unit on the farm.

2. General

• Mix-up time before dosing: Duration for mixing of the component before it is
dispensed into the mixing tank.

• Mix-up speed: Speed of the agitator for mixing before dispensing.

On (fixed setting): Agitators with direct switch-on

Slow/Fast: Double-stage agitators with tapped winding or agitators with
frequency inverter

• Agitator speed during removal: Speed of the agitator when removing the
component from the mineral dosing unit.

On/Off: Agitators with direct switch-on

Off/Slow/Fast: Double-stage agitators with tapped winding or agitators with
frequency inverter

• Fill in parallel by time: Mineral dosing unit dispenses in parallel according to
time. The correct dosing speed must be configured in the feed move settings.

• Warning if dosing unit runs empty: Generates a warning if the mineral
dosing unit runs empty during removal.

3. Calibration

• Result amount: Delivery rate of the mineral dosing unit during the runtime set
under "Time calibration".
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• Time calibration: Runtime for calibrating the mineral dosing unit.

• Start calibration: Starts calibration of the mineral dosing unit.

• Speed (only an information): Calculated speed of the mineral dosing unit after
calibration.

4. Agitator

• Error/Pause state: Speed of the agitator in the event of an error or during a
pause.

On/Off: Agitators with direct switch-on

Off/Slow/Fast: Double-stage agitators with tapped winding or agitators with
frequency inverter

• Deviation: The speed of the agitator is maintained for as long as the weight
does not deviate by more than this value from a supporting point of the
agitation curve. (Only for agitators with an agitation curve already created.)

• Max. speed: Maximum frequency of the agitator. (Only for agitators with
frequency inverter.)

• Min. speed: Minimum frequency of the agitator. (Only for agitators with
frequency inverter.)

• Delay from slow to fast: Delay time when switching from slow mixing to fast
mixing. (Only double-stage agitators with tapped winding.)

• Delay from fast to slow: Delay time when switching from fast mixing to slow
mixing. (Only double-stage agitators with tapped winding.)

The calibration process is carried out as follows:

a) Define a period for which the mineral dosing unit should run, e.g. 10 seconds,
under Time calibration. 

b) Place a container underneath the mineral dosing unit to collect the dispensed
amount.

c) Click on "Start" under Start calibration and the mineral dosing unit starts
dispensing for the set time. 

d) Weigh the amount dispensed into the container after the mineral dosing unit
has completed dosing.
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e) Enter the weight under Result amount. 

The Speed is only an information calculated from the values Result amount
and Time calibration.

7.3.3 Pump settings

The "Pump settings" dialog is only displayed for pumps with frequency inverter.

• Device name (only an information): Name of the pump.

• Location (only an information): Location of the pump on the farm.

• Max. speed: Maximum frequency of the pump.

• Min. speed: Minimum frequency of the pump.

• Measure interval: Interval for speed measurement.

• Reaction time: Waiting time between speed change and start of the next
measurement.

• Max. deviation: The speed (Hz) of the pump is maintained for as long as the speed
(kg/min) does not deviate by more than this value from the speed (kg/min) set in
the "Expert settings".

• Allowed pressure deviation: The speed of the pump is maintained for as long as
the pressure does not deviate by more than this value from the pressure set in the
"Expert settings".

• Max. adj. per step: Maximum step size for speed adjustment.

• Shared frequency inverter: Shared frequency inverter to be used.

• Water impulse time: Duration of the water pulse before the pump starts.

• Water impulse type: How the water pulse valve works.

• Everytime: Water pulse before each pump start.

• WhenPumpIsDry: Water pulse before pump start only if the pump has
previously run dry.
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7.4 Feed preparation (mixing tank, agitator)

The "Mixing tank" dialog is divided into 6 areas, which are explained below.

1.

• Name: Name of the mixing tank.

• Location (only an information): Location of the mixing tank on the farm.

2. General

• Capacity: Capacity of the mixing tank. If the amount in the mixing tank exceeds
this value, an alarm is generated. This value should be greater than the value
set under "Max. amount" due to the residual flow volume.

• Max. amount: Maximum amount up to which the mixing tank is filled. This
value should be smaller than the value set under "Capacity" due to the residual
flow volume.

• Min. amount: Minimum amount which should remain in the mixing tank during
removal, e.g. to prevent the pump from running dry.

• Agitator off amount: The agitator is switched off if the amount in the mixing
tank falls below this value during distribution.

• Min. mix amount: Minimum amount for mixing in the mixing tank.
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• Min. clean amount: Amount of cleaning component used for tank cleaning if
the specified amount for tank cleaning is smaller than this value. This amount
is used for rinsing the mixing tank after fogging. If fogging was part of cleaning
and cleaning is canceled, the mixing tank is still rinsed with this amount before
the safety switch is released.

• Mix-up time before dosing: Duration for which the tank contents are mixed
before the used water is dispensed into the mixing tank or pre-mixing tank.
(Only for used water tanks with agitator.)

• Mix-up speed: Speed of the agitator when mixing the tank contents before
dispensing. (Only for used water tanks with agitator.)

On/Off: Agitators with direct switch-on

Off/Slow/Fast: Double-stage agitators with tapped winding or agitators with
frequency inverter

• Tank content: Displays and adjusts the tank contents.

• Feed curve: The mixture is calculated based on the selected feed curve and
the corresponding feeding day.

• (Force pre-mixing via circuit: no function)

• (Max. waiting time if premixing: no function)

• Direct distribution: If feed still remains in the tank at the start of feeding, with
a higher DM content than set under "DM threshold for direct distribution",
distribution starts immediately.

• DM threshold for direct distribution: The mixture in the tank must have a
pre-defined dry matter fraction before distribution starts immediately.

3. Agitator

• Error/Pause state: Speed of the agitator in the event of an error or during a
pause.

On/Off: Agitators with direct switch-on

Off/Slow/Fast: Double-stage agitators with tapped winding or agitators with
frequency inverter

• Deviation: The speed of the agitator is maintained for as long as the weight
does not deviate by more than this value from a supporting point of the
agitation curve. (Only for agitators with an agitation curve already created.)

• Max. speed: Maximum frequency of the agitator. (Only for agitators with
frequency inverter.)
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• Min. speed: Minimum frequency of the agitator. (Only for agitators with
frequency inverter.)

• Delay from slow to fast: Delay time when switching from slow mixing to fast
mixing. (Only double-stage agitators with tapped winding.)

• Delay from fast to slow: Delay time when switching from fast mixing to slow
mixing. (Only double-stage agitators with tapped winding.)

4. Fast curve

• Fill amount: Setting of the fast agitation curve. From this amount in the mixing
tank, the agitator runs at the speed set under "Speed".

• Speed: Setting of the fast agitation curve. From the amount set under "Fill
amount" in the mixing tank, the agitator runs at this speed.

5. Slow curve (only for mixing tanks with double-stage agitator with tapped winding
or agitator with frequency inverter)

• Fill amount: Setting of the slow agitation curve. From this amount in the mixing
tank, the agitator runs at the speed set under "Speed".

• Speed: Setting of the slow agitation curve. From the amount set under "Fill
amount" in the mixing tank, the agitator runs at this speed.

6. Pause distribution settings

• All-full time span: All sensors must have reported "full" for this period of time
before distribution is paused.

• Pause time span: Feed distribution is paused for this time period.

7.5 Pump

There are three different pump types. The type of each pump is defined in the
Composer. 

• Pump with direct switch-on

• Pump with frequency inverter

• Pump with shared frequency inverter

No settings must be configured for pumps with direct switch-on. In the case of pumps
with shared frequency inverter, multiple pumps share one frequency inverter. This is
only possible if pumps never operate at the same time for process reasons. 
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Speed control for pumps with frequency inverter

For all feed moves carried out with a pump with frequency inverter, set the following
parameters under "Expert settings" > "Feed move settings" in a specific case: 

• standard speed

• slow speed (speed for fine dosing)

This is the case where the control system can determine a speed, i.e. source and target
differ and at least one of the two tanks is weighed or the feed move has a flow meter.

If no speeds are specified, i.e. the speeds are 0, the components are pumped at
maximum frequency for "standard speed" and at minimum frequency for "slow speed"
(speed for fine dosing). The control system memorizes the best frequency it was able
to determine for standard and low speeds for each feed move and for each feed valve
where feed is dispensed after a feed move. The control system uses this memorized
value for the next feed move.

• Name: Name of the feed pump.

• Location (only an information): Location of the feed pump on the farm.

• Max. speed: Maximum frequency of the feed pump.

• Min. speed: Minimum frequency of the feed pump.

• Measure interval: Interval for speed measurement.

• Reaction time: Waiting time between speed change and start of the next
measurement.

• Max. deviation: The speed (Hz) of the feed pump is maintained for as long as the
speed (kg/min) does not deviate by more than this value from the speed (kg/min)
set in the "Expert settings".

• Allowed pressure deviation: The speed of the feed pump is maintained for as
long as the pressure does not deviate by more than this value from the pressure
set in the "Expert settings".

• Max. adj. per step: Maximum step size for speed adjustment.

• Shared frequency inverter: Shared frequency inverter to be used.

• Minimal pressure: The pump must deliver at least the pressure set here.
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• Monitor delay: Monitoring for the minimum pressure starts after the pump start,
following the time set here.

• Monitoring time: The system pressure must be below the minimum pressure for
the indicated period after monitoring has started. Otherwise, an alarm is generated.

• Water impulse time: Duration of the water pulse before the feed pump starts.

• Water impulse type: How the water pulse valve works.

• Everytime: Water pulse before each start of the feed pump.

• WhenPumpIsDry: Water pulse before the feed pump starts only if the feed
pump has previously run dry.

7.6 Distribution (main circuits)

• Time span filling: The time period required to fill the main circuit completely at the
start of feeding. 

• Time span emptying: The time period required to empty the main circuit
completely after the end of feeding.

• Max. deviation filling/emptying: This parameter is based on the deviation to the
content volume.
The control system must be able to pump at least the set percentage into the feed
circuit during filling. If this is not the case, the system goes into error mode.
When emptying the circuit contents into the tank, at least the set percentage must
reach the tank.

• Current pipe content: Describes the type of pipe content.

• Filled with feed
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• Filled with lye

• Filled with acid

• Filled with water

• Empty (default setting)

• Content volume: The content volume (also called pipe content) is calculated
automatically from "Pipe type" and "Pipe length". The volume can also be entered
directly if the box "Enter Volume" is checked. The parameter "Pipe length" is
deactivated in this case.

• Pipe type

• Pipe length: If the box "Enter Volume" is checked, it is not possible to make inputs
for the pipe length.

• Dosing time water: "Dosing time water" is the opening time of the water valve
during cleaning. The pipes are cleaned by water within this time. Afterwards, air is
pushed through the pipes, see the next parameter, "Usage time air".

• Usage time air: Air is pushed through the pipes during this time after they have
been flushed with water.

• Clean amount mix: In case of cleaning with recipe, this amount is mixed
additionally.

• Recirculate after pause time: After a pause, the pipe content recirculates for this
time before it is distributed. This parameter refers to "Feed preparation" parameters
or to the manual pause (by stopping the system).

• All usage locked: This main circuit is locked for feeding and cleaning.

Enter volume: If this box is checked, the column "Content volume" is activated. You
can then enter a volume into the cells manually for each main circuit (i.e. per line).
If the box is not checked, you can enter the "Pipe length" for each main circuit to
calculate the content volume automatically.
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7.7 Scales

In the "Scales" dialog, silos and tanks can be tared and calibrated. 
Procedures and image sections are valid for different liquid feeding systems.

• Name: Name of the silo or tank.

• Location (only an information): Location of the silo or tank on the farm.

• Calibration: Opens the calibration menu of the scale previously linked under
"Setup" > "IO Manager".

• Current values (only an information)

Weight: Current weight on the scale.

Raw value: Current raw value of the scale.

• Taring: Taring requires successful calibration. After calibration with standard
calibration values, taring is mandatory (preferably with a tare value of "0.000
kg"); after calibration with individual calibration values it is optional.

Tare value: Tare value of the scale. This value can be used to reset the zero
point of the scale, for example.

Raw value deviation (only an information): Deviation from the raw value of the
original calibration

Tare scale: Tares the scale.



CulinaMixpro settings  Page 143

CulinaMixpro
Edition: 12/2024     99-94-0696 GB 

• Calibration (see see chapter 3.3.3 ”Calibrating the scale”, page 60 for a
description of the calibration process)

Use standard calibration values: Standard calibration values saved in the
software are used instead of individual calibration values.

Weighing bar type: Weighing bar type for standard calibration.

Weighing module: Type of weighing module installed in UniScale.

Number of weighing bars: Number of weighing bars of the scale.

Calibration points: Number of calibration points to be used. A minimum of 2
calibration points must be used.

Calibration point: List of defined calibration points.

Weight: Known weight for individual calibration.

Raw value: Raw value for the known weight in case of individual calibration.

Set raw value: Sets the value set under "Raw value" for the known weight in
case of individual calibration.

Minimum scale change value: Minimum change of the scale value.

Reset: Resets the calibration.

Calibrate: Calibrates the scale, either after selecting standard calibration
values or after entering and setting individual calibration values.
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• Display

Display unit: Weight unit of the UniScale display (only when used).

Decimal places: Number of decimal places of the value shown on the
UniScale display (only when used).

Save: Saves the display settings.

7.8 Expert settings

Under "Expert settings", you can configure precise settings for each individual feed
move.

The dialogs "FeedMoves" (1), "FeedMove settings" (2), "Subcircuit overview" (3) and
"Container chains priority" (4) can be opened from here.

7.8.1 Feed moves

Define switch times and the switch order for feed moves under "FeedMoves".

NOTICE!

These settings should only be configured by a service technician.
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The "FeedMove overview" dialog is divided into 4 areas, which are explained below.

1. Filter

• Source: Source of the feed move. In case of multiple selection, at least one
source must be correct.

• Contained devices: Devices included in the feed move. In case of multiple
selection, all devices must be contained.

• Target: Destination of the feed move. In case of multiple selection, at least one
target must be correct.

• Devices not contained: Devices not included in the feed move. In case of
multiple selection, no device may be contained.

• Milling method: Milling method included in the feed move. When "Don't care"
is set, the setting is ignored.

2.

• Start FeedMove: Device order: Switch-on sequence of the feed move. This
automatic assignment according to the arrangement of the devices in the feed
move (defined switch-on path of the devices) can be adjusted manually by
right-clicking.

• Start value (only an information): Start value of the device (switched on/
switched off).

• Start waiting time: Delay time after switching on the device.

3.
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• End FeedMove: Device order: Switch-off sequence of the feed move. This
automatic assignment according to the arrangement of the devices in the feed
move (defined switch-off path of the devices) can be adjusted manually by
right-clicking.

• End value (only an information): End value of the device (switched on/
switched off).

• End waiting time: Delay time after switching off the device.

• End partial stop: If the device is used in the next feed move, it remains
switched on to prevent the device from switching on and off too often.

4. Max. stop time

• Automatically calculated stop time (only an information): Sum of the feed
move's waiting times plus the residual flow time for the feed move.

• Additional stop time: Time for which the system should wait for the feed
moves to end when the system stops, in addition to the time displayed under
"Automatically calculated stop time".

• Max. stop time (only an information): Maximum time for which the system
should wait for the feed moves to end when the system stops. Results from the
sum of the values under "Automatically calculated stop time" and "Additional
stop time".

7.8.2 Feed move settings

The "FeedMoveSettings" dialog is divided into 2 areas, which are explained below.
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1. Filter

• Source: Source of the feed move. In case of multiple selection, at least one
source must be correct.

• Contained devices: Devices included in the feed move. In case of multiple
selection, all devices must be contained.

• Target: Destination of the feed move. In case of multiple selection, at least one
target must be correct.

• Devices not contained: Devices not included in the feed move. In case of
multiple selection, no device may be contained.

• Milling method: Milling method included in the feed move. When "Don't care"
is set, the setting is ignored.

2.

• FeedMove (only an information): Name of the feed move, containing at least
the source and the target of the feed move. If the source or target is not in the
selected application, the application name precedes the source or target.

• Start devices (only an information): Devices required to start or stop the feed
move.

• Backlash time (residual flow time): Time for measuring the residual flow
time. (This time does not apply to feed moves for feeding or watering at a valve
or for pushing to a valve. The corresponding times in the general settings are
used for these purposes.)

• Backlash mass (residual flow volume): Residual flow volume determined by
the control system. (This value does not apply to feed moves for feeding or
watering at a valve or for pushing to a valve. The measured residual flow
volume under "Expert settings" > "Subcircuit overview" > "Valves" is used for
these purposes.)

• Residual flow adjustment factor: Weighting of the last residual flow volume
determined by the control system to calculate the value displayed under
"Backlash mass".

• Threshold of weight-based dosing: If the amount to be dispensed falls below
the sum of this value and the value set under "Backlash mass", the system
automatically uses time-based dispensing.
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• Dosing speed:

Time-based dispensing: calculated dosing speed.

Weight-based dispensing: dosing speed determined by the control system.

• Speed adapt factor: Weighting of the last dosing speed determined by the
control system to calculate the value displayed under "Dosing speed". (Only
relevant for weight-based dispensing.)

• Burst control weight: Only relevant for feed moves

• between two weighed tanks,

• from a weighed tank to itself (recirculation),

• through a flow meter whose source or target tank is weighed,

• from a weighed tank that fills a branch line with jet.

If a weight deviation larger than the value set here is determined while these
feed moves are carried out, the alarm "Unexpected weight loss" is generated.
For the feed move to fill the branch line with jet, the value set here must be
greater than the amount that fits into the branch line.

• Minimum speed: If this speed is not reached, an alarm is generated, e.g. "Silo
empty", "Blockage".

• Control time speed: Time interval in which the speed specified under
"Minimum speed" is checked.

• Normal speed: Target speed of the feed move. Only relevant for feed moves
with a drive that is controlled by a frequency inverter (pump, dosing auger,
etc.). The source or target of the feed move is weighed or the feed move
contains a flow meter. The feed move empties the contents of a branch line
with jet into a weighed tank (see also the parameter "Max. jet drain speed
deviation").

• Slow speed: Target speed of the feed move in case of fine dosing. Only
relevant for feed moves with a drive that is controlled by a frequency inverter
(pump, dosing auger, etc.). The source or target of the feed move is weighed
or the feed move contains a flow meter. The feed move empties the contents
of a branch line with jet into a weighed tank (see also the parameter "Max. jet
drain speed deviation").

• Fine dosing amount: If the remaining amount to be dispensed is smaller than
this amount, the system switches to fine dosing.



CulinaMixpro settings  Page 149

CulinaMixpro
Edition: 12/2024     99-94-0696 GB 

• Minimum mass fast dosing: Minimum amount that is dispensed at the speed
set under "Normal speed". If the total amount to be dispensed is smaller than
the sum of this amount and the amount set under "Fine dosing amount", fine
dosing is applied for the entire amount.

• Normal frequency: Frequency of the frequency inverter for the speed set
under "Normal speed". The normal frequency is adjusted by the control
system. For feed moves to a feed valve, the corresponding settings under
"Expert settings" > "Subcircuit overview" > "Valves" are used.

• Fixed normal frequency: The control system does not adjust the frequency
for the speed set under "Normal speed", but uses the value set under "Normal
frequency". For dispensing into the feed valves or for pushing to a valve, the
corresponding settings under "Expert settings" > "Subcircuit overview" >
"Valves" are used.

• Fixed normal start frequency: Start frequency for controlling the drive during
normal dispensing. "0.0 Hz" means that the start frequency is determined
automatically by the control system.

• Slow frequency: Frequency of the frequency inverter for the speed set under
"Slow speed". The slow frequency is adjusted by the control system. For feed
moves to a feed valve, the corresponding settings under "Expert settings" >
"Subcircuit overview" > "Valves" are used.

• Fixed slow frequency: The control system does not adjust the frequency for
the speed set under "Slow speed", but uses the value set under "Slow
frequency". For dispensing into the feed valves or for pushing to a valve, the
corresponding settings under "Expert settings" > "Subcircuit overview" >
"Valves" are used.

• Fixed slow start frequency: Start frequency for controlling the drive during
fine dosing. "0.0 Hz" means that the start frequency is determined
automatically by the control system.

• Maximum jet drain speed deviation: Maximum deviation from the target
speed for jet emptying ("Normal speed" and "Slow speed"). The compressed
air for the jet is switched on when the measured speed is below the target
speed by this percentage value, and switched off as soon as the speed is
above the target speed by this percentage value.

• Target pressure: Target pressure in the feed move. Only active when using a
pressure sensor in the feed move and when using e.g. a controlled pump.

• Milling method: Milling method in the feed move.
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• Minimum target amount: If the target amount is greater than the amount
specified here and less than 50 % of the target amount has arrived, an alarm
is generated. Only relevant for time-based dispensing.

• Scale to use: Scale to be used in the feed move (system-defined "standard
scale", "source scale", "target scale").

• Max. runtime: Maximum runtime of a feed move if it is not registered by a
scale or a flow meter, e.g. filling a silo with switch-off by sensors in the silo.

• Max. allowed pressure: If the pressure in the pipes as determined by a
pressure sensor exceeds this value for the duration of the time set under "High
pressure monitoring time", the feed pump is switched off.

• High pressure monitoring time: If the value set under "Max. allowed
pressure" is exceeded for this time while a feed move is executed, the feed
move is stopped and an alarm is generated. When "0 s" is set, an alarm is
generated immediately upon exceeding this value.

• Critical pressure: If this value is exceeded, the system stops immediately.

Proceed as follows:

1. Filter the necessary feed moves, if required, e.g. for their start (source), target or
device. 

Drag the horizontal scroll bar at the bottom all the way to the right to see any hidden
parameters. 

2. If you want to define the same setting (value) for multiple feed moves, use one of
the following options for multi-editing: 

a) Select multiple feed moves: 

Hold the Shift key and click on the first and last position to select all positions
inbetween. 

Hold the Ctrl key and click on the individual positions to select multiple
positions.     

b) Right-click into the marked area.

c) Click on "Multi edit". 

This opens a dialog you can use to change the values. 

3. Change the values either in the multi-edit dialog or directly in the respective input
field when editing individual values. 

4. Click on "Save" to save all settings.
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7.8.3 Subcircuit overview

In the "Subcircuit overview", you can define specific parameters, lock valves and carry
out valve tests for each subcircuit.

Circuits

Each mixing tank supplies only one subcircuit. All valves of the subcircuit are treated
identically.

• Curve day: Indication of the curve day.

• Locked: The subcircuit is locked.

• Maximum time dosing: The time period for which feed is dispensed in the
subcircuit until the system switches to the next subcircuit. A valve reporting "empty"
is irrelevant. The cup should fill up within this time.

• Maximum dosing per valve: Maximum number of times a valve can be used for
dispensing before it is locked. This value refers to one feeding cycle.
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• Valve block time: The empty sensor is ignored and the valve is considered full
during this time.

• Time period filling: The time period required to fill the main circuit completely at
the start of feeding or cleaning.

• Time period emptying: The time period required to empty the main circuit
completely after the end of feeding.

• Max. deviation filling/emptying: This parameter is based on the deviation to the
content volume.
The control system must be able to pump at least the set percentage into the feed
circuit during filling. If this is not the case, the system goes into error mode.
When emptying the circuit contents into the tank, at least the set percentage must
reach the tank.

• Current pipe content: Describes the type of pipe content.

• "Empty" (default setting)

• "FilledWater": filled with water

• "FilledFeed": filled with feed

• "FilledCleanAcid": filled with acid

• "FilledCleanLye": filled with lye

• Content volume (pipe content) is calculated automatically from "Pipe type" and
"Pipe length". The volume can also be entered directly if the box "Enter volume" is
checked. The parameter "Pipe length" is deactivated in this case.

• Pipe type

• Pipe length

• Distance from mixing tank: The main circuits can be emptied before the
remaining feed is dispensed using compressed air. The distance to the mixing tank
is required to be able to calculate the amount automatically. Indication in meters.
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• Volume from mixing tank: Pipe content volume from the mixing tank to the first
subcircuit valve. Indication in liters.

• Dosing time water is the water valve's opening time. The pipes are cleaned by
water within this time.

• Usage time of air: Air is pushed through the pipes during this time after they have
been flushed with water.

• Clean amount mix: In case of cleaning with recipe, this amount is mixed
additionally.

• Amount valve clean: Amount for valve or drop pipe cleaning.

• Time valve clean: The time period for which the valve opens for cleaning. The
"Amount valve clean" may pass through the valve during this time.

• Pinch valve closing delay: When switching to the subcircuit, the system waits for
this time before the pinch valve is opened again.

• Recirculation time pre-dosing: When switching e.g. from circuit 1 to circuit 2,
feed recirculates in circuit 2 for this time before it is dispensed.

• Target pressure: This pressure should be maintained in the pipe for the entire
feeding process. The frequency inverter controls the target pressure. Use the
target pressure parameter to regulate for which feed moves feed should be
pumped/supplied more quickly.

• Fixed start frequency: Start frequency for controlling the drive. "0.0 Hz" means
that the start frequency is determined automatically by the control system.

• Dose with closed end valve for better application of the pressure / less pressure
loss with long pipes.
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• Adjustment factor: This factor is a percentage used to adjust the amount for valve
cleaning. The adjustment depends on the remaining amount. The percentage is
subtracted from the total cleaning amount used beforehand. Example: From a
cleaning amount of 20 liters, an amount of 5 liters remained. At an adjustment
factor of 50 %, a total amount of 17.5 liters will be used for the next cleaning.

• Recirculate after pause time: After a pause, the pipe content recirculates for this
time before it is distributed. This parameter refers to "Feed preparation" parameters
or to the manual pause (by stopping the system).

• All usage locked: This subcircuit is locked for feeding and cleaning.

• Target pressure for dosing by air: Target pressure when dispensing by using air.

• Allowed deviation: Permitted deviation for the target pressure (maximum
deviation may be higher or lower than this value) when dispensing by using air. 

• Valve opening time for dosing by air: Opening time of the feed valve during
dispensing by using air (in seconds).

• Max. time for dosing by air: Maximum dosing time in this subcircuit when
dispensing by using air (in seconds).

• Max. dosings by air per valve: Maximum number of dispensing processes per
valve during one feeding period.

• Repetitions of dosing by air: Maximum number of repetitions for dispensing the
remaining feed by using air in this subcircuit.
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Valves

Under this tab, you can lock individual valves or adjust the opening time during which
the valve dispenses feed. 

Valve test

This tab allows testing individual valves. 

1. In the column Wait before, define the waiting time for the switch between valves. 

2. Activate the correct valves individually.

OR

Activate multiple valves at the same time by right-clicking to open the context menu
and selecting the correct valves.
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Valve open and Sensor check only show the progress of the test. Valve open
indicates the currently tested valve.

Sensor check shows the corresponding sensor value. The information under
"Sensor check" is displayed if the box With digital sensor check was checked.    

3. Click on "Start" in the lower command bar to start the test.

4. To stop the test, click on "Stop". 

5. Deactivate valves you had activated for the test, if necessary.     

7.8.4 Priority of container chains

Container chains configured under "Configuration" > "General" > "Container chains"
(see chapter 6 ”Container chains”, page 111) can be ordered here according to
descending priority using the arrows pointing upwards and downwards.

When using container chains, the control system selects the containers that contain the
requested component following the steps below:

1. Only the containers with the highest container priority are considered.
Peculiarity: For components that are obtained from containers with the
corresponding source components by means of special feed moves (e.g. inline
milling), the containers that contain the requested component themselves have
priority, regardless of the container priority.
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2. The top container chain whose containers contain the requested component is
considered. Only those containers are considered starting from which a suitable
feed move exists.

a) Of these containers, the most recently used container is considered. If or as
long as this container is not locked (or can be unlocked) and is not empty
according to the minimum sensor or scale, the component is removed from the
container. Otherwise, the next container in the container chain is considered,
and so on. Starting from the end of the container chain, the next container is
the container at the beginning of the chain, unless it is the last container used.

b) If no unlocked (or unlockable) and non-empty container can be found
(anymore) in this container chain, the container chain listed next, whose
containers contain the requested component, is considered, and so on.

3. The control system makes the container selection in the usual way if no container
chain can be found whose containers contain the requested component and from
which container a suitable feed move exists and whose container is not locked (or
unlockable) and not empty.

The priority of the container chains can be set individually for each application, even if
the applications belong to a shared NetFEED group.
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7.9 Data backup

From BigFarmNet Manager version 3.2.0, the following message regarding data
backup configuration appears after installation or an update. If you only close this
message, it will reappear after a short time.

NOTICE!

The system requires an external storage location for data backup, e.g. a network drive,
an external hard drive or a USB flash drive. As soon as an external storage location
has been indicated, the message no longer appears, irrespective of whether automatic
data backup has been enabled or disabled. 

If an external storage location has already been defined before updating to version
3.2.0, the message does not appear at all.    

We recommend data backups in regular intervals. In case of a data loss, the backup
can then be used to retrieve saved data. 

Remember that you can only retrieve the last data backup. Everything you have
created or changed since then is not included in this backup. This means that the
backup period should be determined depending on the amount of data you produce.
You should find the ideal compromise between acceptable data loss and frequency of
backups based on your individual needs.
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The BigFarmNet Manager provides the following options for data backups:

• Manual backup, which you may carry out at any time when necessary.

• Automatic backup, for which you define a fixed backup period. The data is then
backed up automatically according to the settings.

Open the settings dialog as follows:

1. Click on "Backup...".

OR

1. Click on "Data backup" in the "Setup" menu.
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2. In the window "Data backup", select the desired process using one of the two tabs: 

Automatic backup

The automatic backup is pre-set to "OFF". 

a) Click on "OFF" to turn off the deactivation. 

The button then switches to "ON".

b) Determine the backup period.

c) Select an external storage location.

d) Click on "OK" to accept these settings. 

Or:

Manual backup

a) Select an external storage location.

b) Click on the now active button "Create backup now!"
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8 Task Manager
The task manager allows you to save feeding and cleaning tasks for your specific
feeding system.

8.1 Defining a task

Depending on the "strategy", you can define times and technical settings for feeding
and cleaning in the "Feeding task" dialog. 

1. Click on "Task Manager" in the toolbar.

2. In the application window, click on "Add".

This opens the task dialog.
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3. Define information for the task at the top. 

Fields with bold text are mandatory. 

– Name of the task

– Type is pre-set to "Feeding".

– Application 

– Strategy is the subject of the task: feeding, cleaning or recirculation. Refer to
the following chapters for information on the strategies.

– Execute: Daily > Every ... Days: The task should be executed every nth day. 

OR

Execute: Weekly > Days: Select the correct day(s) of the week. 

– From – Until: Time period for this task. The task will not be started outside of
this time period.

– Feeding time: Start time of the task.

All other settings depend on the selected "strategy". These settings are described in
the following chapters. 

8.1.1 Strategy: Piglet feeding

1. Follow the initiatory steps in 8.1.

2. Configure the settings in the lower part of the window under the "Feeding details"
tab:
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a) Select the correct Mixing tank.     

b) Select the Emptying target to which the preparation process should pump part
of the remaining feed if the required dry matter content cannot be achieved
otherwise. Available options are:

• No target (default setting)

• Disposal (slurry tank)

• Remaining feed tank

c) Define the Water prepare time if you want to dilute the feed step by step
before the feeding process ends.

Example: The feeding process ends at 9 p.m. and "Water prepare time" is set
to 120 minutes. Water will be added from 7 p.m. 

Or e)

d) On the set day, the piglets always have fresh feed available. The time is limited
by the "Feeding time" (start time) and the "End time".
Define when feeding should end (End time).

e) Define when the mixing tank should prepare the last feed mixture before the
"End time" (Last mix before end). 

Example: Feeding ends at 9 p.m. and "Last mix before end" is set to 120
minutes. The tank will prepare the last feed mixture at 7 p.m. 

Or c)
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f) Define for how long feed may be dispensed after the end of the feeding process
(Dose time after end). If the last feed mixture has been prepared shortly
before the end of the feeding process, this feed can still be dispensed to empty
the mixing tank as completely as possible. Use "Dose time after end" for this
purpose. 

After feeding

g) Define whether the mixing tank should be emptied (Emptying mixing tank)
after the feeding process, i.e. after the "End time" and/or the "Dose time after
end", e.g. to clean the mixing tank. Select either another mixing tank or the
slurry tank for the tank contents. When emptying a mixing tank, the remaining
feed is usually supplied to older animals. 

h) Define whether the pipe should be emptied by means of air (Emptying pipe)
after the feeding process, i.e. after the "End time" and/or the "Dose time after
end".

i) Use Emptying target (After feeding) to define where the mixing tank contents
should be emptied after feeding, i.e. after the "End time" and/or the "Dose time
after end".
Depending on the selected mixing tank and emptying tank, the following
targets for emptying are available:

• Without emptying (default setting)

• Disposal (slurry tank)

• Remaining feed tank

• Mixing tank X

j) Use Emptying target alternative (After feeding) to define where the mixing
tank contents should be emptied after feeding, i.e. after the "End time" and/or
the "Dose time after end", if the first "Emptying target" (after feeding) is
overfilled.
Depending on the selected mixing tank and emptying tank, the following
targets for emptying are available:

• Without emptying (default setting)

• Disposal (slurry tank)

• Remaining feed tank

• Mixing tank X
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k) Use Dispense pipe content with compressed air to define whether the pipe
contents left in the circuits should be dispensed by using compressed air after
feeding, i.e. after the "End time" and/or the "Dose time after end", before the
circuits are emptied.

External order

l) These parameters are not active for the CulinaMixpro plug-in.

3. Click on "OK" after you have configured all settings.

8.1.2 Strategy: Heat exchanger

1. Follow the initiatory steps in 8.1.

2. Configure the following settings for the heat exchanger in the lower part of the
window:

a) Select the Mixing tank, and thus also the circuit.     

b) Define the End time at which the heat exchanger should stop. 

c) Define the Temperature deviation. The temperature in the heat exchanger is
slightly higher than in the mixing tank. The heat exchanger is equipped with a
temperature sensor. The "Equipment" window of the mixing tank shows the
heat exchanger's temperature in the graphical depiction. 

3. Click on "OK" after you have configured all settings.
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8.1.3 Strategy: Tank cleaning

1. Follow the initiatory steps in 8.1.

2. Configure the following settings for tank cleaning in the lower part of the window:

– Tank: Selection of the tank to be cleaned.

– Emptying before: Indicate whether the tank should be emptied before it is
cleaned. If yes, select a different tank or the slurry tank for the tank contents.

– User acknowledgement before: If the box "User ACK before" is checked, the
system waits for manual confirmation before starting the cleaning process. 

– Emptying after: Select the tank into which the cleaning amount should be
emptied.

– User acknowledgement after: If the box "User ACK after" is checked, the
system waits for manual confirmation before completing the cleaning process. 

– Cleaning: Checking this box activates cleaning. The control system now
needs additional information.

– Cleaning component: Can be changed when checking the box "Cleaning".
The following components are available:

• Liquid additive

• Liquid

• Water (default setting)

• Whey
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– Water type: If you selected "Water" as cleaning component, you can choose
either warm water or cold water here.

– Cleaning amount: Should be greater than the minimum cleaning amount.

– Fogger 1: Should the first fogger be used for fogging of the tank?

– Fogger 2: Should the second fogger be used for fogging of the tank?

– Fog time: Duration of the fogging process. The foggers are started with a delay
if fogging is carried out in another tank beforehand.

– Waiting time after fogging. The tank to be cleaned is always rinsed with water
("Min. cleaning amount") after the waiting time after fogging has elapsed.

3. Click on "OK" after you have configured all settings.

8.1.4 Strategy: Circuit cleaning by means of compressed air

1. Follow the initiatory steps in 8.1.

2. Configure the following settings for circuit cleaning in the lower part of the window: 

– Mixing tank: Selection of the mixing tank whose circuit should be cleaned.

– Emptying before: Indicate whether the mixing tank should be emptied before
it is cleaned. If yes, select a different mixing tank or the slurry tank for the tank
contents.

– Emptying before alternative: Alternative emptying target for the mixing tank
contents before cleaning.

– User acknowledgement before: If the box "User ACK before" is checked, the
system waits for manual confirmation before starting the cleaning process. 

– Emptying after: Select the tank into which the cleaning amount should be
emptied.
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– Emptying after alternative: Alternative emptying target for the mixing tank
contents after cleaning.

– User acknowledgement after: If the box "User ACK after" is checked, the
system waits for manual confirmation before completing the cleaning process.
Use this parameter to ensure that cleaning has been completed correctly. 

– Water type: Select either warm water or cold water.

– Clean also blocked circuits: Should any blocked circuits also be cleaned?

– Clean all circuits that can be reached: If this box is checked, absolutely all
circuits the system can reach will be cleaned without exception. This is also the
case if the circuits have not been explicitly assigned to the tank.

3. Click on "OK" after you have configured all settings.

8.1.5 Strategy: Circuit cleaning according to a recipe

1. Follow the initiatory steps in 8.1.

2. Configure the following settings for circuit cleaning in the lower part of the window: 

– Mixing tank: Selection of the mixing tank whose circuit should be cleaned.

– Parallel with other tanks: If specific tanks are cleaned with their own recipes,
multiple mixing tanks can be cleaned at the same time.

– Emptying before: Indicate whether the mixing tank should be emptied before
it is cleaned. If yes, select a different mixing tank or the slurry tank for the tank
contents.

– Emptying before alternative: Alternative tank for emptying in case the first
tank is already full.

– User acknowledgement before: If the box "User ACK before" is checked, the
system waits for manual confirmation before starting the cleaning process. 

– Emptying after: Select the tank into which the cleaning amount should be
emptied.
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– Emptying after alternative: Alternative tank for emptying in case the first tank
is already full.

– User acknowledgement after: If the box "User ACK after" is checked, the
system waits for manual confirmation before completing the cleaning process.
Use this parameter to ensure that cleaning has been completed correctly. 

NOTICE!

We recommend this setting when cleaning with lyes to ensure that the tank and pipes
are empty before feeding starts. Pipes and tank are usually flushed with some water
after cleaning with a lye. 

– Clean also blocked circuits: Should any blocked circuits also be cleaned?

– Clean all circuits that can be reached: If this box is checked, absolutely all
circuits will be cleaned without exception. This is also the case if the circuits
have not been explicitly assigned to the tank.

– Recipe: Selection of a cleaning recipe that was created beforehand.

– Waiting time: Time for soaking in the pipes. The cleaning agent remains inside
the pipes for this time.

– Recirculation time: Time period for which the cleaning agent is recirculated in
the subcircuit (in seconds).

– Washing time: The cleaning component is pumped from the mixing tank
through the pipes and back into the tank within this time.

– Washing amount: The additional amount of the cleaning agent or water used
for cleaning.

– Empty pipe after: Define whether the pipe should be emptied by means of air
after the cleaning process. 

– Clean valves: When this box is checked, the feed valves are also cleaned
during circuit cleaning. 

– Clean only empty valves: Only valves whose trough reports empty are
cleaned. Can be selected after the box "Clean valves" has been checked.

– Clean locked valves as well: Locked valves are also cleaned, e.g. in empty
pens. Can be selected after the box "Clean valves" has been checked.

3. Click on "OK" after you have configured all settings.

8.1.6 Strategy: Valve cleaning

1. Follow the initiatory steps in 8.1.
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2. Configure the following settings for valve cleaning in the lower part of the window: 

– Mixing tank: Select the mixing tank whose circuit, and thus the corresponding
valves, should be cleaned.

– Emptying before: Indicate whether the mixing tank should be emptied before
it is cleaned. If yes, select a different mixing tank or the slurry tank for the tank
contents.

– Emptying before alternative: Alternative tank for emptying in case the first
tank is already full.

– User acknowledgement before: If the box "User ACK before" is checked, the
system waits for manual confirmation before starting the cleaning process. 

– Emptying after: Select the tank into which the cleaning amount should be
emptied.

– Emptying after alternative: Alternative tank for emptying in case the first tank
is already full.

– User acknowledgement after: If the box "User ACK after" is checked, the
system waits for manual confirmation before completing the cleaning process.
Use this parameter to ensure that cleaning has been completed correctly. 

– Clean only empty valves: Only valves whose trough reports empty are
cleaned. 

– Clean also locked valves: Additionally clean locked valves, e.g. in empty
pens.

– Recipe: Selection of the saved cleaning recipes, available under
"Configuration" > "Cleaning" > "Recipes".

3. Click on "OK" after you have configured all settings.
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8.1.7 Strategy: Tank cleaning according to a recipe

1. Follow the initiatory steps in 8.1.

2. Configure the following settings for tank cleaning in the lower part of the window:

– Tank: Selection of the mixing tank to be cleaned.

– Emptying before: Indicate whether the mixing tank should be emptied before
it is cleaned. If yes, select a different mixing tank or the slurry tank for the tank
contents.

– User acknowledgement before: If the box "User ACK before" is checked, the
system waits for manual confirmation before starting the cleaning process. 

– Emptying after: Select the tank into which the cleaning amount should be
emptied.

– User acknowledgement after: If the box "User ACK after" is checked, the
system waits for manual confirmation before completing the cleaning process.
Use this parameter to ensure that cleaning has been completed correctly. 

– Recipe: Selection of a cleaning recipe that was created beforehand.

– Washing time: The cleaning component is pumped from the mixing tank
through the pipes and back into the tank within this time.

– Amount: The cleaning agent amount for this cleaning process. Select an
amount as large as possible for effective cleaning.

3. Click on "OK" after you have configured all settings.

8.1.8 Strategy: Manual action

The "Manual action" strategy is used to start manual actions of feed moves that have
been saved as a pattern (see chapter 3.5 ”Manual actions for the feed moves”, page
81).

1. Follow the initiatory steps in 8.1.
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2. Configure the following settings for manual operation in the lower part of the
window:

• Manual action pattern: Pattern to be executed for manual feed move actions.

3. Click on "OK" after you have configured all settings.
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8.2 Editing a task

As soon as a task has been created, it will appear in the overview of the Task Manager.
The following functions are available:

1. View the tasks by clicking on the correct system or location where the system is
installed in the farm structure.

On the farm level, all tasks of all systems are displayed.

2. Select a time period, if necessary.

– Display of days, weeks or months

– Display of any time period 

– Return to the current date by clicking on "Now"

3. Adjust the view, if necessary.

– Sort according to "Feeding time" or the name ("Task").

– "Show deactivated task"

– "Show only tasks with start time"

– "Show only feeding time locations"

4. You may edit feeding times as follows. First, select the correct feeding time by
clicking on it.
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– "Add" = add a new task.

If you have created feeding time patterns, you will be asked whether you want
to select an existing pattern. If applicable, select a pattern from the drop-down
menu. Click on "Next".

– "Edit" = edit the selected time or the entire connected task.

Select the correct option and click on "OK".

– "Disable" = deactivate or delete the selected time or the entire connected task.

Select the correct option and click on "OK". 
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– "Start" = immediately start the selected action, even if a different time was
saved.
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9 Silo Manager

9.1 Overview

With the Silo Manager, you can monitor and manage the data of all your silos.

The Silo Manager offers the following functions:

• registering the amounts of feed unloaded from the silos

• calculating the expected storage duration of the silo contents

• receiving a warning when a silo requires filling

• managing suppliers and prices for each feed component

– BigFarmNet automatically calculates the total delivery amounts and your feed
costs based on this information.

Open the Silo Manager by clicking on the respective icon in the toolbar.

The view "Silo Manager" shows the current data of your silos.

• Hiding and showing columns:

a) Right-click into the head line to open the context menu with all parameters. 

b) Select or de-select parameters to hide and show the respective columns.

• Rearranging columns:

a) Click into the head line of the respective column and hold the mouse button.

b) Drag the column to the desired position.

The arrows showing up at the head line when you move the columns help you
assign the new position. 
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c) Release the mouse button.

The column is now at its new position.

• Sorting based on dates:

Click on the respective parameter in the head line to sort the silos in ascending or
descending order according to the given values.

During configuration in the Composer, you assigned the correct locations to the silos.
If you click on a house in the farm structure, you will only see the silos of this house.

The lower part of the application window shows additional silo data. The General
category shows general information about the selected silo. Data under Loading
(delivery, ) and Settings () can be edited.

9.2 Silo data 

Additional silo data is displayed in the lower part of the application window based on
the following categories:

• General

• Loading (delivery)
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• Unloading (consumption)

• History

• Settings

In the categories "Loading" and "Settings", it is possible to edit the data of the individual
silos. 

General

The "General" category shows general information about the selected silo.

The category "Loading" shows previous deliveries to the selected silo. You may add
further deliveries, edit or delete them. Click on the button "Export" to export a CSV or
XLS file with the data for further use.

Proceed as follows to add a delivery:

1. In the table, click on the silo you want to edit.

2. Under the category "Loading", click on "Add".

3. Complete the information in the next window:

– Supplier (mandatory)

– Delivery number

– Delivery date

– Amount and component (mandatory)
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– Average values by checking the box "Calculate":

Useful in case the silo already contains a component, but the newly delivered
component has deviating values for the dry matter fraction or energy. The
current values are displayed by default.
If the box is checked, the changed values are not immediately accepted, but
average values based on the changed and previous values are used. To this
end, the amount of the current delivery is correlated to the current silo weight
("Current weight" in the "General" category). The resulting average values are
grayed out.

– Dry matter fraction

– Energy

– Price

– Total cost (calculated automatically if information on the price and amount is
entered)

4. Click on "OK" to accept these settings.
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The "Unloading" category shows all quantities that have been removed from the
selected silo up to now. Click on the button "Export" to export a CSV or XLS file with
the data for further use.

All feed removed from the selected silo in the past seven days is displayed in the
"History" category as a bar chart. 
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Clicking on the button "Details..." opens the consumption history in a separate window,
in which you can select the time period as required. The consumption history can be
printed. 

1. Enter the correct dates under "Start period" and "End period".

2. Select a time period: hour, day, week or month.

3. Clicking on the "Print Preview..." button opens a print preview to print out the data.

Define the most important information about the selected silo under "Settings".

1. In the table, click on the silo you want to edit.

2. Under the category "Settings", click on "Edit".

3. Change the following settings, if necessary:

• Name of silo

• Components or Recipes indicate the silo's content.
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• Weighed indicates whether the silo is weighed. 

• Lock outlet is a manual setting.

• Unlock outlet automatically means that the automatic locking is
automatically cancelled after delivery. A silo is locked automatically when its
contents have been completely used up.

• Capacity is the maximum amount which can be filled into the silo.

• Warning amount (relative) or Warning amount (total): If you enter one of
these values, the other one is calculated automatically.

The relative warning amount refers to the silo's capacity.

If the silo weight falls below the (total, i.e. absolute) warning amount, the
system can create a warning for a critical fill level (Create warning).

• Use the field Priority to sort the silos. The higher the priority value, the higher
the chance that the component will be removed from this silo.

• Tare is used to set the silo's weighing system to zero. This is only possible if
the silo is completely empty.

• Information regarding the Last tare date

NOTICE!

BigFarmNet automatically blocks a silo whose content has been completely used up.

After each delivery, check whether the box next to “Block outlet” has been checked by
BigFarmNet and if necessary remove the check.

4. Click on "OK" to accept these settings.
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10 Alarms and warnings
Alarms and warnings are registered by the control computer, which transmits the
message to BigFarmNet Manager. BigFarmNet Manager indicates alarms and
warnings as follows:

Clicking on the pop-up window or the alarm icon in the tool bar opens the window for
alarms. It shows all active alarms and warnings. Alarms and warnings are listed in the
order of their occurrence.

If you click on a location with an alarm or warning icon in the farm structure, only
problems active in the respective location are displayed.
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Alarm types

Alarm categories

Icon
Status Descriptionwithout with

user note

Active alarm Not acknowledged: Cause still exists.

Inactive alarm Not acknowledged: Cause no longer exists.

Deactivated alarm Acknowledged: Cause still exists.

Ended alarm Acknowledged: Cause no longer exists.

Active warning Not acknowledged: Cause still exists.

Ended warning Acknowledged: Cause no longer exists.

Info
Information about an incident that has 
occurred.

Icon Category

Climate: temperature, humidity

Control or test (system-specific)

IO connection

BigFarmNet system or general

Dry feeding system

Liquid feeding system

Production

WebAccess
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NOTICE!

Always eliminate causes for alarms in the "Climate" category first.

10.1 Filtering alarms

Alarms can be filtered according to category as well as cause.

1. Open the drop-down menu under "Filter" in the right-hand part of the window.

By default, all categories are selected.

2. Click on "Clear" to delete all check marks.

3. Check the boxes of the correct categories and confirm by clicking on "OK".

Gateway (ISOagriNET)

CallMatic system

EasySlider system

HydroMixCallMatic system

MillAndMix system

SiloCheck system 

TriSort system

Icon Category



Page 186 Alarms and warnings

CulinaMixpro
Edition: 12/2024      99-94-0696 GB 

4. Select the correct cause from the drop-down menu under "Alarm".

The alarms will be displayed according to the selected filter.

5. To deselect the alarms, click on "Reset".

The selection is discarded and all alarms are listed.

10.2 Acknowledging an alarm

Alarms can be acknowledged once their cause has been eliminated. The alarm is
marked with the corresponding icon (see alarm types) in the table and the system no
longer requires action from the user. 

1. Save a note for an alarm before acknowledging it, if required.

This note may be helpful to eliminate similar alarms later on. Notes are saved for
each alarm in the lower part of the window under User Notes. Save the note.

2. Select the alarm you want to acknowledge by clicking on it.

You may also select multiple alarms to acknowledge them at the same time.
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3. Right-click to open the context menu and click on "Acknowledge selected".

4. Click on "Acknowledge" in the next window.

The alarm is removed from the Alarm window.

10.3 Alarm log

The log shows all alarms that have occurred since initial operation of BigFarmNet
Manager. You may filter for specific alarms or delete alarms that are older than six
months as follows:

1. Click on "Delete..." in the right-hand part of the window.
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2. Select the desired time period or enter a date.

3. Click on "OK".

All alarms within the selected time period are deleted.
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10.4 Alarm Notification

Alarm Notification is a service that sends alarms via email. Alarm notification via SMS
is currently not supported. 

To use the Alarm Notification service via email, configure the service in BigFarmNet
Manager. The following technical conditions must be met for email notifications: 

• Internet connection

• running BigFarmNet Manager

NOTICE!

The Alarm Notification service cannot replace an autocaller! The service is merely an
additional help.

Carry out the following steps to set up the Alarm Notification service:

1. In the "Manager" menu, click on "General settings".

This opens the dialog window "General settings".

2. Click on "Configure general E-mail settings".

This opens the dialog window "E-mail settings".

3. Click on the arrow pointing downwards next to Server defaults and select your
server default from the drop-down menu.

As soon as you have selected a server default, the email server, the server port
and the SSL are filled in automatically.

4. Enter the user name, the password and the sender email.

5. Click on "Save" to accept all settings.
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6. Click on "Alarm Notification..." in the "Setup" menu.

This opens the dialog window "Alarm Notification".

7. Activate the Alarm Notification service in the tab "Configuration".
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8. In the tab "Receivers", click on "Add" to add a recipient.

9. Enter the contact details and select the correct language.

10. Confirm your inputs by clicking on "OK".

11. Select "Email" as notification type and confirm your selection by clicking on "OK". 

12. Select whether the recipient should receive alarm messages, warnings or both
under Notification level and confirm your selection by clicking on "OK". 
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13. Under Where, select the location whose alarms the recipient should receive.

You may select multiple locations.

14. Confirm your selection by clicking on "OK" in the drop-down menu. 

15. Under Alarms, select which alarm categories the recipient should receive.

You may select multiple alarm categories.

16. Confirm your selection by clicking on "OK" in the drop-down menu.
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17. Activate the recipient for alarm notifications.

18. Check the recipient's data by sending the recipient a test message:

Click on the alarm notification icon and confirm the next dialog with "Yes".

19. Click on "Close" after you have configured all settings.

This closes the dialog window.
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11 Service Access
The "Service Access" function mirrors the display of the control computer or climate
computer and its control functions in BigFarmNet Manager to provide remote control.

NOTICE!

Service Access requires a password which you create as user of BigFarmNet Manager,
see the manual "BigFarmNet Manager – Installation/Configuration".

1. Click on the controller icon  of the respective system application in the farm
structure.

2. In the tool bar, click on  "Service Access".

The application window shows the display of the connected control computer.
Remote control is deactivated for now.

3. Click on "Activate".

This opens the dialog window for entering the password.

4. Enter the password and confirm by clicking on "OK" to allow remote control.
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12 Operation of the control computer 

NOTICE!

Some screenshots in this chapter may have been taken from other liquid feeding
applications and can therefore show deviating names. Their structure and contents are
still applicable for the application described in this manual, however.

The CulinaMixpro application uses the 510pro
control computer to control the CulinaFlex
feeding system for suckling pigs. The
CulinaFlex feeding system can also be
controlled independently of BigFarmNet
Manager by the 510pro control computer. 

The control computer and BigFarmNet
Manager constantly exchange data when they
are connected. All control computer data are
transferred to the Manager PC in the farm office
and vice versa.

12.1 Technical data

Dimensions (H x W x D) 381 mm x 400 mm x 170 mm
Protection rating according to EN 
60529

IP 54

Supply voltage 115 V, 200 V and 230 V/240 V AC +/- 10 %
Supply frequency 50/60 Hz
Power consumption 75 VA
Network 2 network interfaces, 10/100 BASE+TX RJ 45
USB 2 USB interfaces, USB 2.0 type A, max. 4 GB
Ambient temperature -10 to +45 °C (+14 to +113 °F)
30 punch holes for metric cable gland M 25 x 1.5
Code no. 91-02-4094
Description Base computer 510pro Quad Core 10" display HW2
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12.2 Icons

Application overview / Start screen

Silo overview

Settings

Alarm

An alarm is active.

Log out

Close the current view and return to the previous view

Open additional information or settings

Scroll up or collapse a sub-menu

Scroll down or expand a sub-menu
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12.3 Login

Log into the control computer using the login dialog.

The login dialog appears

• automatically after the software has been installed successfully, when the
application starts;

• automatically after a specific time without activity (automatic logout); or

• if you actively log out of the control computer.

NOTICE!

The user name and the password are the same as when logging into BigFarmNet
Manager.

12.4 Logout

To log out, tap on the button in the top right corner. A new button appears. Tap on the
"Logout" icon.

The login dialog appears on the display again.
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12.5 Application overview

After logging in, the application overview appears with a list of all available applications
and the respective location.

If sub-applications are available, they can be expanded and collapsed by tapping on
the corresponding icon at the end of the line. In addition, the applications and sub-
applications can be started and stopped by tapping on the icon in the "Action" column.

By tapping on the corresponding buttons, the applications can be filtered according to
the "House" and "Pen" levels.

12.6 Silo overview

The silo overview shows a list of all silos and dosing units with their respective location,
content and current outlet status. The outlet status in the "Locked" column can be
changed by tapping on  or :

• Lock: The unlocked outlet  is locked immediately after confirmation.

• Unlock: The locked outlet  is unlocked immediately after confirmation.
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12.7 Settings

Switch to the settings by tapping on the corresponding icon.

No application settings can be configured here, only general and technical settings.
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12.8 Alarms

In case of an active alarm or warning, the alarm icon has a red dot indicating the total
number of alarms and warnings.

1. Tap on the icon to open the alarm overview.

In the alarm overview, the different alarms and warnings are shown in a list and
sorted depending on when they occurred. The list provides the following
information:

– Alarm type (see chapter 10 ”Alarms and warnings”)

Active alarm: Icon  and red vertical line on the left

Inactive alarm: Icon 

Active warning: Icon  and yellow vertical line on the left

Deactivated alarm (only in "History"): Icon 

Ended alarm (only in "History"): Icon 

Ended warning (only in "History"): Icon 

– Description of the alarm or warning

– Time of occurrence
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2. Tap on the correct alarm or warning to read the full description and to acknowledge
the alarm or warning, if necessary.
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